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This manual presents the user interface of Amaya. The user interface on your computer could be a little
different, depending on your system and its configuration. This is not a complete user manual. Its
purpose is only to help you to discover the main features of the software.

This document is organized as a book and you can use the Tools/Make Book command to build and
print the whole manual.

Many commands in Amaya are the same as those provided by common word processors and editors.
They are not presented here. Only the specific aspects of Amaya are described.
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1. Browsing
Amaya is mainly an editor with browsing capabilities. It allows you to edit and browse Web documents
simultaneously. Browsing with Amaya is similar to browsing with other Web browsers except for
activating a link and using forms.

Amaya allows you to display and edit HTML documents as well as some XML document types:
XHTML, MathML (mathematical expressions) and SVG (gaphics). It also allows you to access other
XML document types and to display their content according to their CSS style sheets. For these XML
documents some editing functions are available.

1.1. Activating a link
Because Amaya is both a browser and an editor, you get different results when you single-click, double-
click, or right-click a link.

• Single-click a link to move the cursor to that position in the document. The status bar
displays the expanded URI of the link. You can now edit the content of the link.

• Double-click a link to activate it and skip to its target. The document retrieved by this
operation replaces the current document in the same tab as the original document. If the original
document was modified and has not been saved yet, a dialog box is displayed. It allows you to
save the changes you have made before replacing the original document.

If you have chosen a profile without the navigation feature, or if you are in help pages, the
retrieved document is displayed in a new tab.

• Right-click a link (or Cmd + Single-click on MacOS X) to activate the link and open the
target document in a new tab or a new window (a pop-up menu allows you to choose).

This behavior can be changed through the Browsing tab under the Preferences dialog. By changing
option Double click activates link, you can browse documents with a single click as you would in a
traditional Web browser. You will then not be able to edit the content of a link by clicking it, but you can
move the cursor within a link with the arrow keys.
Other browsing preferences such as whether images should be loaded or not, whether CSS style sheets
should be applied or not, can be set in the Browsing Preferences dialog.

You can also use the keyboard to select links and to activate them. Key Tab allows you to move to the
next link or form field in the document. Shift Tab allows you to move to the previous link or form
field. Alt ↓ activates the current link. You can choose other keys to perform these commands.

1.2. Access keys
Access keys provide shortcuts for moving the cursor to a form field, an area, or a link. This kind of
access is crucial to people with motor disabilities, but there are other conditions where it could be
necessary or useful.

When developing a web document, you can associate the accesskey attribute with the following
elements: a, area, button, input, label, legend, and textarea.

For example, if you associate the accesskey attribute with a link in a document using accesskey="n"
or accesskey="N", command Alt-accesskey (Alt-n or Alt-N in this example) will activate that link
(on MacOS X, use Ctrl instead of Alt). If the accesskey attribute is associated to a form element,
pressing Alt-accesskey moves the focus to that element (or to the following element if associated with
a label or legend element).

1. Browsing
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Access keys overwrite Amaya shortcuts, but not the system shortcuts (shortcuts for menus, for instance).

As an example, these Help pages declare the following access keys:

• "n" for going to the next page

• "p" for going to the previous page

• "t" for the table of contents

So, if you have assigned shortcut Alt-p to an Amaya command, this shortcut won't work in a Help page;
it will display the previous page instead.

By default, Amaya uses the Alt key as the modifier for access keys (Ctrl on MacOS X). However, you
can change this modifier using thePreferences/General dialog box. You can choose the Ctrl key
instead of the Alt key for a modifier, or you can disable the access key mechanism.

1.3. Target anchors
Targets are elements that have been given an id attribute, or anchors (element a) that have been given a
name attribute. They identify possible targets for links.

You can easily recognize targets and set links to them: Amaya allows you to display target icons in
front of all targets. These icons are not part of the document and can be displayed or hidden in two ways:

• Choosing Show targets from the Views menu.

• Using the default keyboard command (Ctrl-u Ctrl-t).

1.4. Moving backward and forward
Like most web browsers Amaya maintains a log to keep track of the pages you have visited during the
current session. You can move backward or forward through pages in this log in several ways:

File menu
Choose Back from the File menu to view the previous page.

Choose Forward from the File menu to view the next page.

Keyboard shortcuts
Press Alt-← to view the previous page.

Press Alt-→ to view the next page.

Navigation bar

Click the back button to view the previous page.

Click the forward button to view the next page.

Note that each tab has a separate log.

If you have chosen a profile without the navigation feature, or if you are in help pages, these commands
are not available.

1.5. Reloading a page
Documents can be reloaded by:

• Choosing Reload document from the File menu.

• Using the shortcut Ctrl-r.
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• Clicking the Reload button on the navigation bar.

If you have chosen a profile without the navigation feature, or if you are in help pages, this command is
not available.

2. Using forms
As Amaya is an editor, some of the widgets associated with HTML form elements are different from
those you are used to in browsers. This section mentions the most notable differences.

2.1. Simple menus
To activate a selector such as this one: apple , you have to click twice on the current entry ("apple"
here). This will result in a popup widget showing all the entries. The widget can then be used both with
the keyboard and with the mouse.

With the keyboard, you must first select an entry using the arrow keys. Pressing the Enter key validates
your choice. You can abort by pressing the Esc key at anytime.

With the mouse, there are two kinds of behavior. A single click allows you to select an entry, whereas a
double click on an entry means that you want to activate this entry. To abort, you just need to click
anywhere outside of the pop-up widget. With very long menus, you can also use the scroll bar to quickly
navigate through the entries.

2.2. Menus with multiple selections
Some menus, like this one : apple

orange
lemon
banana
strawberry

allow multiple entries to be selected simultaneously. This widget

behaves much like a simple menu. When the widget is activated, it shows the current state of selection.
You can abort by using either the Esc key or by clicking elsewhere.

2. Using forms
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3. Viewing documents
Amaya can present different views of a document simultaneously. Each tab corresponds to a document
and the document views can be shown by splitting the page so you can clearly see what is happening
when you edit complex documents.

The multiple views can also help you move quickly through a document. For example, if you click a
heading in the Table of Contents view, the Formatted view will display the document section you
selected.

Six views are available.

Formatted view (default)

This view is similar to that provided in most browsers. It is a dynamic, direct-manipulation view. At
all times it displays the changes you make to the document. This view is allways visible in your
page.

Structure view

This view shows the actual structure of the document. Each element is represented by its tag name,
followed by its attributes on the same line. The elements it contains are represented underneath,
next to a blue vertical line that shows the extent of the element.
You can directly edit any text displayed in black by clicking and typing. You must use the editing
commands to change text displayed in blue.
The structure view shows all the elements of the document even those that are not displayed in the
formatted view like comments, doctype, processing instructions or the elements of the head section.
This view also shows the uri of the namespace used by the author when an element belongs to a
namespace that is not the same as its parent.

Alternate view (not available with the Lite profile)

This view shows how the document looks when displayed by a text-only browser. It is useful for
checking the accessibility of your documents.

Links view

This view shows a list of all anchors in the document and the elements each anchor contains. You
can focus on it when working primarily on links.

Table of contents view

This view shows a list of all headings (Hn elements) in the document. If the document is well
structured, it displays an overview of the document.

Source view

This view shows the actual source code of the document. You can use it to edit the syntax of your
document. (this view is opens by default when you click on the pink area at the bottom of your
document)

You can open and close any view at any time.

3.1. Opening a View
To open a view, select the appropriate Show menu item from the Views menu:

Entrée du menu Raccourci clavier

3. Viewing documents
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Show structure Ctrl-u Ctrl-s

Show alternate Ctrl-u Ctrl-a

Show links Ctrl-u Ctrl-l

Show table of contents Ctrl-u Ctrl-c

Show source Ctrl-u Ctrl-o

Tip : You can quickly open the source view by clicking on the pink bar at the bottom (Horizontal split/
unsplit) or at the right (Vertical split/unsplit) of the your document.

3.2. Closing a view
To close a view, select the Split view horizontally or Split view vertically command from the Views
menu. Another way to close a view is to double-click on the pink bar at the bottom or at the right of your
document.

You can also close the tab (File/Close tab or close button on the tab, or right click on the tab, except for
the Mac OS X version) if you want to close your document and all its views.
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4. Selecting
Many commands in Amaya act on the current selection. You can make a selection using the keyboard or
the mouse, as described below.

No matter how you make the current selection, Amaya displays the type of the first selected element at
the bottom of the window, preceded by the types of the enclosing elements in the structure. This may be
helpful when the document structure is complex.

For example, selecting a word in this sentence displays the following message in the status bar:

html > body > div > p

meaning that the selection is within a p element, which is within a div element in the body of the html
document. This sequence of element names is called a path.

Selecting this character string (for example click on the word "character") displays

html > body > div > p > strong

4.1. Selecting with the mouse
• To set the insertion point, click with the left mouse button.

• To select some text, drag across a region: hold down the left mouse button, move the mouse,
and release the button when the desired text is selected.

• To select an entire word, double-click on any character of the word.

• To select a whole element such as this list item, click its bullet or number.

• To extend the selection, click with the left mouse button while holding down the Shift key.

• To select a structure element, click within the element you want and then select the desired
structure level via the keyboard as described below

4.2. Selecting in the status bar
• To set the insertion point, click with the left mouse button.

• Click in the status bar (at the bottom of the window) on an element name to select an ancestor
(and everything in it).
In the previous example, when cliking on div in the status bar, the enclosing division is selected
html > body > div > p > strong

• When the selection is changed this way, the path is not updated and you may adjust the final
selection on any ancestor or descendant element.

4.3. Selecting with the keyboard
Selecting a structure element

• Press the F2 key to select the parent element in the document structure. Press that key several
times to select ancestors (and everything in them) up the structure towards the root.

• Press Shift-F2 to select the first child of the current element.

• Press F4 to select the next element at the same level (sibling), or at the level of the parent
element if there is no next sibling at the current level.

• Press Shift-F4 to select the previous element at the same level (sibling), or at the level of the
parent element if there is no previous sibling at the current level.

4. Selecting
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Moving the insertion point

• To move the insertion point locally, use the four arrow keys. If there is no insertion point, one is
set at the top left corner of the window.

• To move the insertion point to the beginning or the end of the line, use keys Home and End
respectively.

• To move the insertion point to the beginning of the previous or next word, use keys Ctrl-← and
Ctrl-→.

Extending/shrinking the selection

• To extend or shrink the current selection, use the Shift key together with the arrow keys
(Shift-←, Shift-→, Shift-↑, Shift-↓).

• To extend the current selection to the beginning of the previous word or to the end of the next
word, use Shift-Ctrl-← and Shift-Ctrl-→.

Moving across the document

• To scroll the document one line up or down, use Ctrl-↑ and Ctrl-↓.

• To skip to the befinning or the end of the document, use Ctrl-Home and Ctrl-End.

4.4. Selecting images
To select an entire image:

1. Click and drag anywhere within the image, and then release the mouse button. Be sure not to
drag outside the image before releasing the mouse.

2. Use the copy, cut, and paste commands to move or duplicate the image element along with all
its attributes.

To place the cursor to the left or to the right of an image:

• Click the left part of an image to move the cursor to the left edge of that image. This enables
you to type text before the image.

• Click the right part of an image to move the cursor to the right side of that image. This enables
you to type text after the image.

Note: When using the arrow keys, the cursor moves to one side of the image, and then to the other
side.

4.5. Selecting in the structure view
The Structure view is especially convenient for quickly selecting large elements or groups of elements
within a document.

To select an element in the Structure view:

• There are three ways to select a large element like a complex table or a long list with a single
click: Click the blue label that represents the element, click the name of any of its attributes, or
click the blue vertical line associated with that element.

To select a character or a text string:

• Click a character in the Structure view to select only that character. To select a text string, click
and drag across the text.
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To select an attribute value:

• In the Structure view, attribute values that can be edited from the keyboard are displayed in
purple. Click and drag across the attribute value to select it. You cannot extend this text
selection outside the attribute value, but you can edit the value.

4. Selecting
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5. Creating and opening documents
5.1. Creating a new document
Amaya allows you to create both local and remote documents. Three types of documents are available:

• New document, to create a document including text, links, formulae, etc.

• New formula, to create a single mathematical formula

• New style sheet, to create a CSS style sheet

To create a document:

1. Choose New from the File menu, and then select the file type you want to create.

2. At the prompt, type the URI or the local path name of the new document (a default name is
assigned to the document if no name is specified). You can use the file browser to find a local
directory.

3. Choose the location of the new document : Replace current, In new tab or In new Window.

4. If you are creating a new XHTML document:
◦ When a title of the new document is requested, Amaya generates a default title (the file

name without the suffix). That title could be updated later by the Tools/Change title
command.

◦ If you plan to use a template, click the From template toggle and select a template,
either by selecting in the list of registered templates or by typing the URI or file name
of a template that is not in the list. To update the list of available templates, see
Preferences/Templates

◦ If you do not want to use a template, you may specify the Document profile of the
new document (XHTML Transitional, XHTML 1.1, XHTML strict, XHTML basic,
HTML transitional, Compound document). You may use the default profile proposed
by Amaya.
If you want to create a XHTML document including either MathML or SVG elements
(Compound document), it is recommended to create a document file with a .xml
suffix.

5. You may select a charset to encode strings in the document. Pay attention, if you plan to
publish your document on a server, this charset should be selected in accordance with the Web
server that will serve the document (contact your web master).
By default .html pages are served with iso-8859-1 and .xml pages are served with utf-8.

6. Click Create. The new document is open, and a root element is created.

5.2. Opening a document
You can open local and remote documents in several ways:

File menu

1. Choose Open document from the File menu.

Note: You can alternately use a keyboard shortcut to open a document. Press Ctrl-o ctrl-o.

2. In the Open document dialog, type the full path or URI of the file you want to open, or use the
Browse button (a file icon) to open a file selection dialog.

3. When the document is correctly specified, click Open.

5. Creating and opening documents
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You can also use these steps to create a new local document, by specifying the name of a file that
does not exist.

Files browser

A file browser may be displayed in the tools area with Views / Show toolbars / Files. This tool
gives access to all local directories. A simple click allows you to open or close a directory and a
double click on a file name opens the corresponding document.

Document address field

Note that this method works only if you have chosen a profile with the navigation feature.
The address of the current document is displayed at the top of the window. Edit this address to
specify the file name or the URI of the document you want to open and press Enter.
You can also create a new document by typing the name of a document that does not exist yet.

Note: You can click the button on the right side of the document address field to display the list of
the documents you have opened recently. You can then select an address in this list to open the
corresponding document.

Links

By activating a link you load the target document.

Note about character sets

Amaya reads HTML and XHTML documents differently:

• Amaya reads HTML documents by default as ISO-Latin-1 files. If an author does not provide
information about the character set (charset) in the HTTP header or in a meta element, Amaya
considers an HTML document to be encoded in ISO-Latin-1.

• Amaya reads XHTML documents by default as UTF-8 files. If an author does not provide
information about the charset in the HTTP header, in the XML declaration, or in a meta
element, Amaya considers an XHTML document to be encoded in UTF-8.

Because the default charset is different for HTML and XHTML documents, authors often create
documents using the incorrect charset. For example, consider an XHTML document that uses ISO
Latin-1 but does not provide information about the charset. When the XML parser analyzing the
document encounters a sequence of bits that does not match a valid UTF-8 character, the document is
considered to be not well formed. Parsing stops and Amaya displays an error message that proposes
either to reload the document as an HTML document or to show parsing errors. If show parsing errors is
chosen, Amaya displays the detected errors.
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6. Creating elements
6.1. Editing modes
Amaya offers two editing modes:

• The XML mode is very efficient for manipulating different types of XML structures, but it
requires from the user a good knowledge of the document structure. The simple manipulations
performed through a few keystrokes in the XML mode are generic: they can be performed for
any type of element from any XML vocabulary, whatever their semantics. It works well with
HTML text, but also with MathML equations or SVG drawings.

• The Text mode allows users to handle HTML elements in the same way as in a word processor.
That mode does not apply to other XML vocabularies.

You can easily switch editing mode (Text/XML) by clicking on the corresponding button in the bottom
right corner of the window.

6.2. Buttons and menus
Entries of the Insert menu, and the corresponding buttons in the Elements tool, let you create new
elements within a document. To use these commands, place the insertion point at the desired position and
choose the element type.

The Elements tool allows you to immediately

• insert (or replace the current selection by) an XHTML element among the following: division (

), headings ( , , ), paragraph (P), table ( ), target anchor or target element ( ),

link anchor ( ), bulleted list ( ), numbered list ( ), definition list ( ), definition term (

), definition ( ), image ( ), object ( ).

• open/close (or enclose the current selection by) a an XHTML inline element: emphasis ( ),

strong ( ) code ( ), insertion ( ), deletion ( ), superscript ( ), and subscript ( ).

Note: With the Lite profile, only a subset of these buttons and menu entries are available.

For more information about these elements see the list of all HTML 4.0 elements.

6.3. Insertion point
When creating new elements, it is important to select an insertion point, not some text nor a single
character: if the current selection is not empty, Amaya tries to transform the selected part into the
element type chosen.

Sometimes elements can not be created at the chosen location because of the constraints imposed by the
HTML language. Amaya then tries to create the element at the closest valid position in the document
structure. For example, if the insertion point is within a paragraph,at the end of the last line, when you

click on the heading button , Amaya creates the new heading after the paragraph, not within it.

In some other cases, Amaya changes the existing structure for creating the desired element at a valid

position. If the insertion point is somewhere within a list item (li) when you create a heading button ,
the item and its enclosing list are automatically split, in order to create the requested heading at the
chosen position and to comply with HTML contraints.

6. Creating elements
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6.4. Hidden elements submenu
To create elements in the document head, use the Insert/Hidden elements submenu. These elements are
displayed only in the structure and source views. The structure view should then be open. Put the cursor
at the desired position and choose the element type from the Hidden elements submenu.

The Hidden elements submenu also enables you to create comments. Comments are shown only in the
structure and source views, but they can be inserted at any position in the document.

6.5. Generated elements
Some HTML elements are constituted by several other elements of different types. For instance, a table
usually contains a caption (caption), several rows (tr), and several cells (td or th) in each row.

When Amaya creates such elements, it also creates their components. To create a table Amaya displays
a dialog that lets you choose to create it with or without a caption. You can also choose the number of
rows and columns you want and other presentation options. The insertion point is placed automatically in
the first generated cell. You can enter the content of that component immediately or later. You can move
to the next (empty) component with the mouse or with the arrow keys.

HTML defines inline elements that allow you to attach style to character strings. See Creating HTML
Style Elements to create such elements.

6.6. The Enter key
When you are writing a new document or a new part in a document, you can create elements sequentially
by pressing the Enter key. The current element is terminated and a new one is created immediately after.
The type of the new element depends on the HTML DTD.

When the cursor is at the end of a preformatted or a division element (pre or div), hitting the Enter key
creates a new line in the pre or a new paragraph in the div.

In some cases the behaviour of the Enter key depends on the current editing mode:

• XML mode:
To create a paragraph after a pre or a division after a div, you have to select the whole pre or
div element with the F2 key and to press Enter. In the same way, you can create a new
paragraph after a table by selecting the whole table and pressing Enter.
When a whole element like h2 or li is selected the Enter key creates a new h2 or li after.

• Text mode:
When the cursor is at the beginning or at the end of a list item (li), a new sibling list item
element of same type is created, instead of a new paragraph within the list item. In addition, in
an empty list item, the Enter key creates a paragraph that breaks the list.
When the cursor is within elements such as p, address, dt, h1, h2, etc. (they are called block
elements) the Enter key splits the element into two sibling elements of same type.
When the insertion point is in HTML elements such as strong, em, code, span, a, etc. (they are
called inline elements), the Enter key splits the inline element and the event is transmitted to
the parent element. As inline elements may be nested in a HTML structure, the split may
happen at several levels, until the event reaches a block or list item element, which processes
the event as explained above.
When the Enter key is hit at the beginning or at the end of a block element, a new paragraph (p
element) is created, whatever the type of the current block element.

When the new element created is simply a paragraph, you can change the element type by selecting the
desired type from the Insert menu or by clicking the corresponding button in the Element tool. You can
also keep typing and change the element type later on.
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6.6.1. Exiting anchors, inline elements, etc.
When a paragraph or another block of text is terminated by an anchor or a character string in bold, italic
or other such inline element, moving the insertion point to the end and typing new text appends
characters to the anchor or the inline element.

In XML mode only

To exit an inline element and enter plain text:, move the cursor to the end of the anchor or style
element, and then press Enter and continue typing after the element.

The same method can be used to enter plain text at the beginning of a block starting with an inline
element. Move the cursor to the beginning of the anchor or style element, and then press Enter and
continue typing before the element.

In Text and XML mode

All Information type and Character elements can be set On/Off with the same command or
button of the Elements tool.

The Insert or Append commands of the Edit menu or contextual menu can be used to insert before
the beginning or after the end of the inline element.

6.6.2. Creating nested structures
In XML editing mode (only), when the insertion point is in an empty element, pressing the Enter key
replaces that element by another empty element at the next higher level in the document structure. This
feature allows you to create complex, nested structures very quickly.

As an example, consider the following structure:

1. The first item in the list
A paragraph in the first item

2. The second item in the list.
a. First item in the nested list.
b. Second item in the nested list.

3. Last item in the list

To create the above structure:

1. Click the Numbered List button to create the first item in the list.

2. Type in the list item text, and press the Enter key once. Amaya creates a new paragraph within
the list item.

3. Type the paragraph text, and press the Enter key twice. The first Enter creates another
paragraph element, but the second Enter removes that paragraph and creates a second list item
in the original list.

4. Type in the second list item content.

5. Click the Numbered List button to create a new list. The new list is automatically nested
within the first list.

6. Type the text for the first item in the new, nested list, and press the Enter key twice to create a
new item in the nested list.

7. Type the text for the second list item, and press the Enter key four times to create a new list
item in the original list.

6. Creating elements
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8. Type the final list item, and then press the Enter key three times to close the original list and
start a new paragraph after the list.

The Enter key works in the same way when the insertion point is at the beginning of an element, but it
creates new elements before the current element. For example, to add a list item between the first two
items in the above structure, place the cursor at the beginning of the second list item, and press the Enter
key twice.

Note: In XML mode, this use of the Enter key does not apply only to lists and paragraphs, but to all
elements.

6.7. The Delete and Backspace keys
The behavior of the Delete and Backspace keys does not depend on the editing mode.

• If the insertion point is at the beginning or at the end of a block element and the Delete or
Backspace key is hit, the whole content of the next (resp. previous) sibling element is merged
with the content of the element that includes the insert point.

• When the insertion point is in inline elements the Backspace and Delete keys only delete
characters, crossing inline element boundaries without any action on the structure. However,
when an inline element becomes empty by deletions, it is itself deleted.

6.8. Changing the document title
To edit the document title:

• Open the Tools menu and choose Change title.

Note:
You can also edit the document title from the structure view.

6.9. Insert time stamp
The Tools/Insert time stamp menu entry allows you to insert the current date either in the ISO format
(YYY-MM-DD) or in the European format (DD-MM-YYYY). The date format is set by the Preference
menu.

Once the date is inserted, Amaya automatically updates it every time the document is saved and so
maintains the last update date.
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7. Editing attributes
You can edit attributes in two ways:

• Using the Attributes tool.

• Directly in the structure view.

7.1. Editing attributes through the Attributes tool
The Attributes tool can be used to create an attribute, change the value of an existing attribute, or delete
an attribute. It displays:

• The list of attributes already applied to the first selected element and their current value.
Mandatory attributes are displayed in red and cannot be removed.

• Below, a combo box labelled Insert provides the list of all attributes that may be applied to the
first selected element.

To add an attribute to an element:

1. Click within the element and press the F2 key to select the element of interest.

2. When the element is selected, choose in the Insert combo box the attribute you want to add.
This attribute is now activated.

3. For boolean attributes (such as ismap for an image), the command is finished.

4. For attributes with a limited set of predefined values (such as lang), you have to select a value
in the list of possible values.

5. For other attributes you have to edit the value, then confirm either with the Enter key or with

the apply button ( ).

To change the value of an attribute:

1. Click within the element and press the F2 key to select the element of interest.

2. When the element is selected, click on the name of the attribute you want to modify, to display
the editing form of its value.

3. For attributes with a limited set of predefined values (such as lang), Amaya displays:
◦ A combo box giving the list of possible values.

◦ A button ( ) to remove the attribute.

4. For attributes with a free value (such as href for an anchor), Amaya displays:
◦ An input box to insert the value.

◦ An apply button ( ) to confirm the inserted value. The Enter key can also be used to
confirm the value.

◦ A button ( ) to remove the attribute.

To remove an attribute from an element:

1. Click within the element and press the F2 key to select the element of interest.

2. When the element is selected, click on the name of the attribute, to display the editing form of
its value.

3. Click on the delete button ( ) to remove the attribute.
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7.2. Editing attributes in the structure view
All attributes are displayed in the structure view. Attribute values may be displayed in blue or purple.
When the value is displayed in blue, you can only change it with the Attributes tool. This ensures that
only one of the predefined values is chosen.

Attributes with a free value can be edited in the structure view.

• You can click within the attribute value (displayed in purple) and edit the value like any other
character string.

• To select the whole value, you can click within the value then hit the F2 key.

• To remove the attribute, you can select the whole value, then press the Delete key twice. The
first Delete removes the attribute value and the second removes the attribute itself.

7.3. Copying attributes
An attribute is not the same thing as an element, and an attribute can not be copied by the Copy/Paste
entries on the Edit menu. Only a textual attribute value can be copied/pasted.

8. Entering characters
To enter characters that are not directly available from the keyboard, Amaya uses the standard services
provided by the Operating System. An optional multi-key support is also provided for Motif and
Windows versions.

Amaya provides a mechanism for assigning keyboard shortcuts to characters that are not directly
available from the keyboard. Some of them are pre-defined:

• To enter a non-breaking space, press Ctrl-space
This character is displayed in the source view under the form of the following colored character:
~

• To enter a œ (oelig), press Ctrl-o Ctrl-e

• To enter a Œ (OElig), press Ctrl-Shift-O Ctrl-Shift-E

• To enter a «, press Ctrl-[

• To enter a », press Ctrl-]

The input methods for Unix and Mac OS X are presented below.

8.1. About Unix standard multi-key support
If a character is unavailable on the keyboard, you can insert the character by pressing the special
Compose key followed by a sequence of two other keys. See the table below for the keys used to insert
various characters. Note that in Amaya you can change the order of the two keys.

If your keyboard does not contain a Compose key, you can attach it to an existing key such as Alt-Gr
with the following xmodmap command:

keycode 113 = Multi_key

You can place this command in the $HOME/.Xmodmap file, and Amaya will apply it when you will launch
your X server.

Name Code First key Second key Output
AElig 198 <Shift> A <Shift> E Æ
Aacute 193 <Shift> A quote Á
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Acirc 194 <Shift> A circumflex Â
Agrave 192 <Shift> A backquote À
Aring 197 <Shift> A star Å
Atilde 195 <Shift> A tilde Ã
Auml 196 <Shift> A double quote Ä
Ccedil 199 <Shift> C comma Ç
Eth 222 - D Ð
Eacute 201 <Shift> E quote É
Ecirc 202 <Shift> E circonflex Ê
Egrave 200 <Shift> E backquote È
Euml 203 <Shift> E double quote Ë
Iacute 205 <Shift> I quote Í
Icirc 206 <Shift> I circumflex Î
Igrave 204 <Shift> I backquote Ì
Iuml 207 <Shift> I double quote Ï
Ntilde 209 <Shift> N tilde Ñ
Oacute 211 <Shift> O quote Ó
Ocirc 212 <Shift> O circumflex Ô
Ograve 210 <Shift> O backquote Ò
Oslash 216 <Shift> O slash Ø
Otilde 213 <Shift> O tilde Õ
Ouml 214 <Shift> O double quote Ö
Thorn 222 <Shift> T <Shift> H Þ
Uacute 205 <Shift> U quote Ú
Ucirc 206 <Shift> U circumflex Û
Ugrave 204 <Shift> U backquote Ù
Uuml 207 <Shift> U double quote Ü
Yacute 221 <Shift> Y quote Ý
aelig 230 a e æ
aacute 225 a quote á
acirc 226 a circumflex â
agrave 224 a backquote à
aring 229 a star å
atilde 227 a tilde ã
auml 228 a double quote ä
brvbar 166 bar (pipe) bar ¦
ccedil 231 c comma ç
cent 162 c slash ¢
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copy 169 c o ©
current 164 x o ¤
deg 176 ^ 0 (zero) °
eacute 233 e quote é
ecirc 234 e circumflex ê
egrave 232 e backquote è
euml 235 e double quote ë
eth 240 - d ð
frac12 189 / 2 ½
frac14 188 / 4 ¼
frac34 190 / 3 ¾
hyphen 173 - (minus) -
iacute 237 i quote í
icirc 238 i circumflex î
igrave 236 i backquote ì
iexcl 161 ! ! ¡
iquest 191 ? ? ¿
laquo 171 < < «
macr 175 - (minus) circumflex ¯
micro 181 / u µ
middot 183 . circumflex ·
nbsp 160 <Ctrl> space (none)
not 172 - (minus) comma ¬
ntilde 241 n tilde ñ
oacute 243 o quote ó
ocirc 244 o circumflex ô
ograve 242 o backquote ò
oslash 248 o slash ø
otilde 245 o tilde õ
ouml 246 o double quote ö
ordf 170 a _ (underscore) ª
ordm 186 o _ (underscore) º
para 182 <Shift> P ! ¶
plusmn 177 + - (minus) ±
pound 163 l - (minus) £
raquo 187 > > »
reg 174 <Shift> R <Shift> O ®
sec 167 s ! §
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sup1 185 s 1 ¹
sup2 178 s 2 ²
sup3 179 s 3 ³
szlig 223 s s ß
thorn 254 t h þ
uacute 250 u quote ú
ucirc 251 u circumflex û
ugrave 249 u backquote ù
uuml 252 u double quote ü
yacute 253 y quote ý
yen 165 y - (minus) ¥
yuml 255 y double quote ÿ

8.2. How to type accented characters on Mac OS X
With an international US keyboard (qwerty), accented characters are entered with the Alt key (aka
Option key) as follows:

• Acute accent (´): alt-e, then the letter

• Grave accent (`): alt-`, then the letter

• Circumflex accent (ˆ): alt-i, then the letter

• Tilde accent (˜): alt-n, then the letter

• Umlaut accent (¨): alt-u, then the letter

• The letter “c” with a cedilla (ç): alt-c

8.3. About white space handling
As required by the HTML specification, Amaya removes insignificant white-space characters when it
loads a document. This applies to (X)HTML, MathML, and SVG documents, as well as MathML and
SVG elements included in a (X)HTML document,

The following are considered as insignificant white-space characters:

• End of line characters (#xD and #xA)

• Tab characters (#x9)

• Leading spaces of an element

• Trailing spaces of an element

• Contiguous spaces (one space is preserved)

To preserve all characters for some elements, use the xml:space attribute or the pre element (only in
(X)HTML documents). The possible values for the xml:space attribute are default and preserve.

• default means that an applications' default white-space treatment is acceptable for these
elements. In Amaya, the default treatment removes the insignificant white-space characters for
all supported DTDs (see above).

8. Entering characters

23



• preserve indicates that applications must preserve all the characters, except the first one that
immediately follows the end tag of the element where it is specified, if that element is an end of
line.

The xml:space attribute applies to all elements within the element where it is specified, unless it is
overridden with another instance of xml:space.

In an XHTML DTD, the pre element causes the same behavior as the xml:space attribute with the
value preserve.
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9. Editing with templates
9.1. What is a template?
Templates are used to produce multiple documents of the same type. A template is a skeleton
representing a given type of document, expressed in the format of the final documents to be produced
(XHTML, for instance). The format of the final documents is called the target language and must be an
XML language.

In a template, the skeleton document contains some statements, expressed in the XTiger language
(eXtensible Templates for Interactive Guided Editing of Resources), that specify how this minimal
document can evolve and grow, while keeping in line with the intended type of the final document.
Documents produced from this skeleton following the XTiger statements are called instances of the
template. Some parts of the template may be frozen, if they have to appear in document instances as they
are. Some parts may be changed when producing an instance document, some others may be added either
freely or under some constraints.

The file containing a template must have a .xtd extension.

A template comes often with a set of accompanying resources (images, style sheets, scripts). A template
is a web resource, that can be stored in the local file system or shared on a remote web server.

9.2. Creating a template
You can create your own templates, using the XTiger language. However, Amaya provides a specific
support for creating or updating templates.

The proposed approach is to:

• Create first a skeleton of the document instance (.html file) you want to generate.

• Select the Template (Tpl) tab of the Elements tool and click on the first entry to generate a
template (.xtd file) from that document skeleton.

• When a template document is selected, several entries of the Template tool are available:
◦ The Create and use a component entry generates a component that will be displayed in

the head of the template document. The current content of the selection becomes the
content of the component.
A use element that allows one to insert that component is created at the current
position of the document. The selection must be valid (a set of complete elements or a
string). The command asks the user for the component name. That name must be
unique.

Note: The content of the component won't be edited in template instances. The user
has to insert use and/or bag elements inside the component to define editable areas.
These editable areas can be inserted before or after the creation of the component.

◦ The Create and repeat a component entry generates a component that will be
displayed in the head of the template document and a use element inside a repeat
element. That command is a shortcut of the Create and use a component and Repeat
the current use commands.

◦ The Create a new types union entry generates a union which defines a new type as a
choice between several basic types (number, string), elements from the target
language (div, h1, h2, p, ...), or component names. The current selection has no effect.
The command asks the user for the union name. That name must be unique.
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◦ The Create a text area entry generates a use element that includes a string. The
command asks the user for a label. That label is free and is used for the selection path
displayed in the status bar. The selection must be string and becomes the initial value
of the use element.

◦ The Use a component or an element entry is used to generate a new use.
If the selection is empty, un dialog proposes the list of elements that can be inserted at
that position and asks the user for the label to be associated with the new use element.
A use element is generated with an empty content.
If an element of the target language (div, h1, h2, p, ...) is selected, a use element that
allows one to insert this element type is generated at that position. The selected
element becomes the initial content of the use element. The command only asks the
user for a label.

◦ The Repeat the current use entry is used to generate a repeat of the current selected
use element. The command asks the user for a label. That label is free and is used for
the selection path displayed in the status bar.

◦ The Create a free editing box entry generates a bag element. The command asks the
user for a label. That label is free and is used for the selection path displayed in the
status bar.

• The created template can stored anywhere, in your local file system or remotely.

9.3. Visualizing template elements
When a document instance is displayed, Amaya shows the XTiger elements under the form of colored
frames that enclose XHTML elements.

• A use element is shown as a dashed blue box

• A bag element is shown as a dashed green box

• A repeat element is shown as a box with a on the top left

• The attribute element is not displayed in the main view, as it only impacts the Attributes
tool.

The XTiger elements can also be seen in the structure view. Open this view with the Show structure
entry of the Views menu. In the structure view, XTiger elements are displayed in gold, while the
XHTML elements are in blue. XTiger elements are also shown in the Source view, but with no special
color.

Another way to understand the nesting of XTiger elements with XHTML elements is the selection path
displayed in the status bar of the window (at the bottom of the window). There, you can see the list of all
elements in the structure of the document from the root element to the current selection. It is updated
every time the selection is changed. In this path, XTiger elements are displayed in gold and XHTML
elements in black. For XTiger elements, it is not the name of the element that is displayed there (use,
bag, repeat) but the label of these elements, as declared in the template.

9.4. Selecting templates
You can select your own templates, or use the templates available on the Amaya web site at
http://www.w3.org/Amaya/Templates/

To ease selection among your favorite templates, there is a Templates section in the Preferences
dialogue (Edit/Preferences, or amaya/Preferences under Mac OS X). Use it to register the templates
that Amaya proposes when you create a new document. When registering a local template, you can call a
file browser with the browse button to locate and select the files to be added to the list. You can also
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enter the URI of remote templates in the input area below the list. Use the buttons on the right side of the
list to remove a template or to change the order of templates in the list.

Registering templates in this list is not mandatory. When you create a new document instance, you can
also choose a template that is not in that list.

9.5. Creating an instance document
To create a new document instance from a template, use entry New/New document in the File menu. It
displays a dialogue where you can select:

• The template, either by selecting in the list of registered templates or by typing the URI or file
name of a template that is not in the list.

• The URI or file name of the document instance you want to create.

• Where to open the new document (Replace current, In new tab, In new window).

• The Title of the new document that will be displayed by browsers (a default title is generated
when the user doesn't specify it).

9.6. Editing an instance document
Editing is allowed only inside the repeat, use, and bag elements, i.e. within the colored dashed boxes.
The rest of the document is the fixed part of the template and can not be modified.

9.6.1. Editing in a repeat element
In a repeat box, you can create new instances of the repeated structure or you can delete one. This is
controlled by the template, which may impose a minimum and/or a maximum number of occurrences of
the repeated structure.

When creating new occurrences of the repeated structure is allowed, + icons are displayed at locations
where you are allowed to create new occurrences. When you click on these icons, you get a pop-up menu
that tells you what can be inserted at that position. By clicking in that pop-up menu, you create a new
occurrence of the corresponding type. In some cases the template offers only one type of occurrence. The
pop-up menu then contains a single entry, to clearly state what will be created. If you click outside the
menu, nothing is created.

Another way to create new occurrences of the repeated structure is to select an existing occurrence, or to
put the caret at the end of an occurrence, and to press the Enter key. A new occurrence of the repeated
structure is then created, provided the maximum number of occurrences is not reached yet. The type of
the new occurrence is then the same as the one that was selected when pressing the Enter key.

When an existing occurrence is empty or fully selected and the Backspace or Delete key is pressed, the
element is deleted, provided the minimum number of occurrences is not reached yet.

9.6.2. Editing in a use element
Most use elements (blue) allow you just to enter free text or to freely replace/edit existing text. Other
use elements offer a choice between different types of elements that can be inserted at that position. In
that case, a blue triangle icon is displayed in the top left corner of the box. By clicking this icon, you can
select one of the allowed types through a pop-up menu. When you have chosen a type, the corresponding
structure is generated and you can freely edit its content.

9.6.3. Editing in a bag element
In a bag box (green), you can insert any number of elements of the types specified by the template.
When you want to insert a XHTML element, do it the usual way provided this type is allowed by the
template. It may happen that some elements are not allowed by the template. The allowed elements are
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listed in the Insert and Append submenus of the contextual menu. The available template components
are also listed in the Insert and Append submenus of the contextual menu.
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10. Restructuring documents
10.1. Changing type
To change the type of an existing element, select it and choose the new type in the Insert menu, or in the
Elements tool. You can change that way a numbered list (ol) into an unnumbered list (ul) or a
paragraph into a heading or a list, for instance.

Element types offered by the submenus Information type and Character element of the Insert menu
work as toggles. If you select some plain text and activate one of these commands, the selected text will
be turned into an element of the chosen type. Conversely, if you select an element of a type listed in
these submenus and you activate the corresponding menu item, the element is removed from the
document, but its content is kept.

Tout select a whole element, put the insertion point anywhere within this element and press key F2.

10.2. The transform command
The Transform command from the Tools menu performs complex structure transformations, based on a
language that specifies how a given structural pattern can be transformed into a different structure. For
example, nested lists can be transformed into a table and back again.

10.2.1. Available transformations
The available transformations are defined in the file Amaya/amaya/HTML.trans. Please refer to the
document "Using the HTML.trans file" for a description of the language in which the transformation
rules are written.

Additional transformations may be specified in the HTML.trans file. Some transformations are provided
in the HTML.trans file as examples.

10.2.2. Using the transform command
The Transform command displays a menu that lists all the transformations that can be applied to the
current selection. You just have to choose the transformation you want.

10.3. Inserting a division
You can easily group a set of paragraphs, headings, lists, tables, and so on within a division. To do this,
select the elements you want to group, and then select Division (div) from the Insert menu or use button

in the Elements tool.

10.4. Merging elements
You can merge successive elements, even if they are not at the same level in the document structure, by
using the Backspace and Delete keys. When the insertion point is at the end of an element, use the
Delete key to merge; when it is at the beginning of an element, use the Backspace key. In both cases,
these keys do not delete any characters; instead they merge elements previously separated by a structure
boundary.

Note that when the insertion point is within an element, the Backspace and Delete keys delete the next
or previous character as usual.
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11. Creating and changing links and anchors
11.1. Creating a target anchor
A target anchor is a piece of text that is referred to by a link (a source anchor). Before creating a link to a
text string, you must first turn it into a target anchor.

To create a target anchor:

1. Select the appropriate text string.

2. Choose Create target from the Links menu or click the button in the Elements tool. The
selected text is now a target.
In the Formatted view, if Views/Show targets is turned on, the target text is preceded by a
target icon . In the Links view, icons that identify target anchors are always displayed.

3. When a target anchor is created, Amaya automatically generates the value of the name attribute
by:

◦ Extracting a word longer than 3 characters from the anchor text, or
◦ assigning a number.

In both cases, Amaya guarantees that the generated value is unique within the document. But
you can change this value, in the same way as the value of any attribute.

Note: If you want to create a link to the last target anchor you have created, choose Link to previous
target from the Links menu.

11.2. Creating a target element
In (X)HTML, any element can be used as a target. A target element is an element with an id attribute to
which a link can refer (a source anchor). Before creating a link to such an element, you must first turn it
into a target element.

To create a target element:

1. Select within the element, then press the F2 key to select the entire element. The selection path
at the bottom of the window may be useful to select the right element.

2. Open the Links menu and select Create target or click the button in the Elements tool. The
selected element now has an id attribute that identifies it as a target element.
In the Formatted view, if Views/Show targets is turned on, the target element is preceded by a
target icon . In the Links view, icons that identify target elements are always displayed.

3. When a target element is created, Amaya automatically generates the value of the id attribute
by:

◦ Extracting a word longer than 3 characters from the anchor text.
or

◦ assigning a number.
In both cases, Amaya guarantees that the generated value is valid and unique within the
document. But you can change this value, in the same way as the value of any attribute.

Note: You can also directly create the id attribute by selecting the element and using the Attributes
list. When you enter an attribute value, Amaya checks it for uniqueness, and changes the value if it is
already used by another name or id attribute in the same document.
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Note: If you want to create a link to the last target element you have created, choose Link to previous
target from the Links menu.

11.3. Creating an external link
To create an anchor that is a link to another document:

1. Select the text for the link you are creating.

2. Click the Link button , or select entry Create or change link in the Links menu, or use the
shortcuts Ctrl-l Ctrl-l.

◦ If the target document is displayed in another window in Amaya, and you want to
designate it by clicking, use the Click button, then click anywhere within that window
or tab to create the link.

◦ If the target document is displayed in another tab and you want to designate it by
clicking, use the Click button, then change the current tab and click anywhere within
the target document to create the link.

◦ If the target document is a local file you can use the Browse button to select it.
◦ Else type the URI (like http://www.w3.org) of the target document and then Confirm

to create the link.

11.4. Creating an Internal Link
To create a link to a target anchor or target element in the same document or in another
document:

1. Select the text for the link you are creating.

2. Click the Link button in the Elements tool, or select entry Create or change link in the
Links menu, or use the shortcuts Ctrl-l Ctrl-l.

◦ If the target is displayed (you may scroll to display it), activate the Click button then
click the target icon to create the link.

◦ Else type the URI (like #name) of the local target and then Confirm to create the link.

Note: If you have created the target anchor or target element recently, instead of step 2 above, select
Link to previous target in the Links menu: the last target you have created will become the target of the
new link.

11.5. Copying a target location
The Links/Copy location command registers the location (URI) of the selected target into the system
clipboard. If no target is selected, the current document URL is registered. This location can so be pasted
into a dialog box or into another external application.

11.6. Changing a link
Use this procedure to change the target of a link without changing its anchor.

To change a link:

1. Click inside the source anchor.

2. Then click the Link button in the Elements tool, or select the entry Create or change link
in the Links menu, or use the shortcut Ctrl-l Ctrl-l.

3. Select the new target as if you were creating a link.
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Note: You can also manually edit the href attribute of the anchor either in the Structure view or in the
Links view, or use the Attributes tool.

11.7. Removing a link or a larget anchor
The Delete link or target entry in the Links menu removes the anchor enclosing the cursor location.

To use this command, put the selection or the insertion point anywhere within the anchor to be removed
(it is not necessary to select the whole anchor), and choose Delete link or target. The anchor is removed,
but its content remains.
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12. Editing tables
Amaya does not contain a separate table editor. To Amaya, a table is simply a structure described by the
(X)HTML document type definition (DTD), like any other element, and it is edited as such. The same
commands apply to tables as to other HTML structures. However, a few specific commands have been
added for more convenient manipulations.

12.1. Creating a new table
To create a new table:

1. Move the cursor to the location in the document where you want to create the table.

2. Click the Table button in the Elements tool, or choose Table from the Insert menu.The
Table dialog displays.

3. Enter the initial number of rows and columns for the new table, and specify the border width,
etc.

4. Click the Confirm button. Amaya generates a graphical representation of the table.

5. The cursor is automatically placed in the first cell.

6. To insert content into other cells, click inside a cell and then insert the appropriate text, image,
etc. Use the arrow keys to navigate from one cell to another.

7. You can also edit the text of the table caption, add it if not already there, or remove it if it is not
needed.

12.2. Adding a new column
To add a new column to a table:

1. To create a new column to the left of an existing cell, select the Insert a column entry in the
Tools/Edit table submenu, or use the corresponding button in the Elements tool , or type
Ctrl-t Ctrl-b.

2. To create a new column to the right of an existing cell, select the Append a column entry in the
Tools/Edit table submenu, or use the corresponding button in the Elements tool , or type
Ctrl-t Ctrl-a.

In XML mode, a new column can also be added to a table using the Enter key. When a whole cell is
selected (use F2), pressing the Enter key creates a new cell and its corresponding column to the right of
the selected cell.

12.3. Removing, copying, pasting a column
When a whole column is selected, you can delete it, copy it, cut it and paste it before or after another
column, in the same or in another table.

To select a column:

1. Use the Select column entry in the Tools/Edit table submenu (Ctrl-t Ctrl-c).

2. You can also start the selection in a cell and extend to another cell in the same column (for
example start in Cell 1.2 and stop in Cell 2.2). Amaya changes to column selection mode.
Hitting the F2 key extends the selection to the whole column.

Cell 1.1 Cell 1.2 Cell 1.3
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Cell 2.1 Cell 2.2 Cell 2.3
Cell 3.1 Cell 3.2 Cell 3.3

When a whole column is selected, use the usual commands to copy, delete or cut it.

Two specific commands are available to paste a column:

1. To paste a column before an existing column, click at the beginning of a cell in the existing
column and use item Paste before of the Tools/Edit table submenu (Ctrl-t Ctrl-p).

2. To paste a column after an existing column, move the cursor to the end of a cell in the existing
column and use item Paste after of the Tools/Edit table submenu (Ctrl-t Ctrl-v).

12.4. Adding a new row
There are two specific commands to create new rows in a table:

1. To create a new row above an existing row, select Insert a row from the Tools/Edit table
submenu (Ctrl-t Ctrl-i), or the corresponding button in the Elements tool .

2. To create a new row below an existing row, select Append a row from the Tools/Edit table
submenu (Ctrl t Ctrl n), or the corresponding button in the Elements tool .

In XML mode, a new row can also be easily added to a table using the Enter key. When a whole row is
selected (use key F2 for that), pressing the Enter key create a new row after the selected row.

12.5. Removing, copying, pasting a row
When a whole row is selected, it is possible to delete it, to copy it, to cut it and to paste it.

To select a row:

1. Use the Select row entry in the Tools/Edit table submenu (Ctrl-t Ctrl-r).

2. You can also start the selection in a cell. Hitting the F2 key extends the selection to the
enclosing row.

When a whole row is selected, you can delete it, copy it, or cut it with the usual commands.

Two specific commands are available to paste a row:

1. To paste a row before an existing row, use the Paste before item of the Tools/Edit table
submenu (Ctrl-t Ctrl-p).

2. To paste a row after an existing row, use the Paste after item of the Tools/Edit table submenu
(Ctrl-t Ctrl-v).

12.6. Extending a cell
To extend a cell, the simplest method is to select the set of cells to be merged by dragging and to call the
Merge cells command in the Tools/Edit table submenu, or to click the corresponding button in the
Elements tool .

Four other specific commands allow you to extend or shrink a cell:

• To extend a cell to the next cell at the right, select Join with the cell at the right in the Tools/
Edit table submenu (Ctrl-t Ctrl-e).

• To extend a cell to the next cell below, select Join with the cell below in the Tools/Edit table
submenu (Ctrl-t Ctrl-j).
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• To shrink an horizontally extended cell by one column, select Shrink horizontal extend in the
Tools/Edit table submenu (Ctrl-t Ctrl-s), or click the corresponding button in the
Elements tool .

• To shrink a vertically extended cell by one position, select Shrink vertical extend in the Tools/
Edit table submenu (Ctrl-t Ctrl-m), or click the corresponding button in the Elements tool

.

Cell extensions can be also changed by editing the colspan and rowspan attributes.

12.7. Adding a new table body (tbody)
Function not available in the Amaya Lite profile.

• To create a new table body above an existing table body, click at the beginning of the first cell
in the first row of the table body and select the tbody item in the Insert/Table submenu.

• To create a new table body below an existing table body, move the cursor to the end of the last
cell in the last row of the table body and select the tbody item in the Insert/Table submenu.

In XML mode, new table bodies can also be easily added to a table using the Enter key. When a whole
table body is selected (use F2), pressing the Enter key creates a new table body after the selected table
body.

Note: Amaya implements HTML 4.0 tables. A table may include several table bodies (tbody), table
headings (thead), and table footers (tfoot).

12.8. Adding something after a table
Many element types may be inserted within table cells. When you click a button in the Elements tool or
you select an entry in the Insert menu, Amaya will try to insert the selected element into the cell that
contains the insert point.

To solve that problem in XML mode, you can select the table element (use F2) and press the Enter key.
Amaya creates a new paragraph after the selected table. This paragraph may be replaced by another
element.

Another method is to select the table element (use F2) and use the Append command in the Edit menu
or in the contextual menu.
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13. Using image and maps
13.1. Adding an image
To insert an image, choose Image from the Insert menu, click the image button, or use the keyboard
shortcut (Ctrl-h Ctrl-i). The resulting dialog lets you enter

• the file name

• the alternate text (alt attribute) of the image

• and the position (inline, on the left side, centered, on the right side)

Note: the alternate text is mandatory. You must provide a short description of the image in the
corresponding field or confirm twice.

To help find an image file you can enter a filter, and use the filter button, and the dialog will list only the
files that match your pattern.

To provide a long description for an image presenting complex information, you should do so in a
separate document and link it by providing the URI as a longdesc. This command is also available on
the Attributes list.

13.2. Replacing an image
If an image is selected (do so by dragging over the image) when opening the image dialog, the selected
image is then replaced by the new image.

13.3. Resizing an image or a map area
After you have inserted an image or defined an area within an image map, you may need to resize it.

To resize the image or map area directly on the screen:

1. Select the image or the area of the image map to display handles.
When you click on an image, Amaya selects the left or right border of the image to let you
insert a text before or after the image.
To display image handles, you have to:

◦ either select a border and press Esc or F2,
◦ or drag over the image

2. When selecting a handle with the left button of the mouse and moving the mouse with the left
button down you are able to resize the image or the area as you want.

◦ Corner handles let you resize both the width and the height.
◦ If the Shift key down, the ratio between the width and the height of the image is kept.
◦ Other handles let you resize either the width or the height.

You may also edit attributes.

13.4. About alternative text and long descriptions
Without useful alternate text for images, many web pages become difficult or even impossible to
navigate, and users are left "feeling their way in the dark."

To prevent this problem, you must provide alternate text for elements such as images and other
multimedia objects. The alternate text is usually presented instead of the image by a browser with a voice
output system, or on a Braille display used by many people who are blind. It is also common for users
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with low-quality connections to request the alternate view, because text is transmitted much faster than
images.

The alternate text should replace the image in function as well. For example, if you use the image as an
icon that links to a reference point, then the title of the reference itself is a good alternate text.

There are cases where an image is used for purely visual effect, and does not add any information value
to the page. In this case, it is appropriate to use a blank alternate text, although you must still define it.

When the image conveys important information that is not available from the text of the document, you
must provide a description of the information. The longdesc option in the Attributes tool enables you
to link a description to the image. This description can be a URI (a separate document), or named part of
the current document.

To view how a page might be presented without the images, use show alternate (Views /Show
alternate). If the page is spoken by a voice output system, then the alternate view might simply be read
out.

13.5. Using client-side image maps
Amaya enables you to use client-side image maps.

To activate an area in an image map

• Double-click on the area within the image. Amaya finds the URI associated to this area, and
opens it in the browser.

To display the existing areas within an image map

• Select Show map areas from the Views menu.

Note: You can also display existing areas directly from the keyboard with Ctrl-u Ctrl-m.
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14. Editing mathematics
Amaya proposes a Wysiwyg interface where MathML mathematical expressions are handled as
structured components, in the same way as (X)HTML elements. Therefore, you can manipulate math
expressions in the same way you manipulate other parts of (X)HTML documents. All editing commands
provided by Amaya for handling text are also available for math, but there are some additional controls
for entering mathematical constructs. Note that the different browsers don't behave in the same way with
MathML: see the browsers compatibility section for more informations.

14.1. Creating mathematical formulae
14.1.1. New formula
Generally, mathematical formulae are not alone but included in a document with text, table, images... to
do this, you have to create a XHTML document. Otherwise, you can create a MathML document (mml)
for instance to use the formulae in other software tools. To do so, use command File / New / New
formula or type Ctrl-n Ctrl-m.

To create a new mathematical expression in a document, move the insertion point to the position where
you want to insert an expression, and then click the Math button (the first) from the Math palette, or
choose Insert a formula from the Insert/Math submenu. Here are examples with a formula inserted
directly in the XHTML document or inside an SVG image :

Γ (x) = ∫0
+∞tx − 1ⅇ − tⅆ t

14.1.2. The Math submenu
The Insert/Math submenu includes presentation MathML elements.

• The first items create new elements of a given type in a mathematical expression : Plain text
(mtext), Identifier (mi), Number (mn), Operator (mo). These commands can also change the
type of a single element or a sequence of elements.

• The next command, Space (mspace), allows you to add space in a formula. To change its size,
you have to modify its width attribute. See spacing.
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• The next item, Character (&xxx;), enables you to enter a character that is not available on the
keyboard. It displays a dialog where you have to enter the character name (for instance alpha
for the Greek character α).
Note that you can also use the Special characters tool (command Views / Show/hide toolbars /
Special characters).

• The two next commands InvisibleTimes and ApplyFunction are used to enter the
corresponding invisible characters. See the special characters section.

Following entries of the Insert/Math submenu enable you to create new constructs within a formula. If
the insertion point is not in a formula, Amaya first creates a math element to accept the new construct.
The available constructs are:

• Root with index, mroot in MathML:
3√x + 1

• Square root, msqrt: √x + 1

• Enclose, menclose: )1234

• Fraction, mfrac:
1

x + 1

• Expression with subscript and superscript, msubsup: xi + 1
n

or ∫0
∞

• Expression with a subscript, msub: xi

• Expression with a superscript, msup: xn

• Expression with under- and overscript, munderover:

n
∑
i = 1

• Expression with underscript, munder:
x
−

• Expression with overscript, mover: x
maps to
→ y

• Expression within parentheses, mrow: (a + b)

• Expression with prescripts and tensor indices, mmultiscripts: k
l Xi

j

• Finally, the New matrice (mtable) entry allows you to create and edit MathML tables:

a
c

b
d

You must then choose the number of lines and columns in the new table through a dialog that
pops up. You can manipulate it like a HTML table through the commands available from the
Tools/Edit table submenu.

14.1.3. The Math palette
Clicking on a button in the Math palette inserts the mathematical construct represented on its icon. Parts
in black are really inserted, parts in red represent placeholder, parts in blue are asked through to a
specific dialog. Green parts are simply additional information that are not inserted.

The palette contains all constructs described in Content MathML (but the produced code is an equivalent
in Presentation MathML, see the known issues section) and even more. You can also save your own
constructs in a mml file in order to use them latter. The 6 tabs are :

1. ◦ Various constructs
▪ new formula
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▪ mrow: used to group elements. See the section about the row construct
▪ mphantom: used to hide a piece of formula, can be used for alignment. The

hidden parts can be viewed if you select the formula :

{ 5x + 3y =
− 2x + 7z = 11
− 3x + 2y − 6z = − 7

▪ parenthesis: (x)
▪ interval: The open, separator and close symbols are asked. [a; b]
▪ fence: Same, but the number of element is asked. [1, c, Y, ⅇ, ∏ }

▪ mtable:

a
c

b
d

▪ menclose: )a or b

▪ selector: The number of coordonnates is asked. ai j

▪ piecewise or vertical brace :
∣ x ∣ = { x if x ≥ 0

− x otherwise

◦ Presentation MathML constructs: msup, msub, msubsup, mover, munder, munderover,
multiscripts.

◦ Sets of numbers: naturals, integers, rationals, reals, complexes, quaternions, primes.
◦ Accents and underscript

2. ◦ relations of equivalence and orders
▪ equalities, approx, congru, isomorphic
▪ inequalities
▪ inf, sup, max and min

◦ logic
▪ True and False
▪ equivalence
▪ universal and existential quantifiers
▪ not, and, or, xor, implies, equivalent to

3. ◦ set theory
▪ set/list built by extension/separation, nuple
▪ element, subset
▪ empty set, powerset
▪ complement, difference, symetric difference
▪ intersection, union, cartesian product
▪ cardinal, omega, aleph, diagonal intersection

◦ functions and maps
▪ lambda construct
▪ map definition, arrows
▪ domain, image (range), codomain
▪ identity, compose, inverse

4. ◦ arithmetic
▪ sum, prod
▪ factorial, combination, cardinal
▪ factor of
▪ lcm, gcd

14. Editing mathematics

43



▪ reminder, quotient
◦ operations

▪ elementary operations: plus, minus, times, divide, fraction
▪ power, root
▪ floor, ceiling

◦ complexes
▪ abs, arg, conjugate
▪ cartesian, polar
▪ real and imaginary part

◦ constants: ⅇ, ⅈ, π, γ, NaN (not a number)

5. ◦ analysis
▪ differential, partial differential
▪ integrals: simple/double/triple, normal/contour, msub/msupsub
▪ equivalence
▪ limit, tends to
▪ supminus (1

-
) or supplus (0

+
)

▪ infinity
▪ o and O

◦ linear algebra
▪ direct sum
▪ vectorrow, vectorcolumn, matrix
▪ transpose, determinant
▪ curl, div, grad, laplacian
▪ vector product, scalar product, outerproduct
▪ orthogonal, parallel, orthogonal complement, norm

◦ statistic : mean, sdev, variance, median, mode, moment

6. classical elementary functions (trigonometric, inverse...)

14.1.4. Entering Math constructs using the keyboard
You are not required to use the Math submenu or the Math palette to create and edit mathematical
expressions. You can enter mathematical constructs directly from the keyboard because each entry of the
Math submenu has a keyboard equivalent. These shortcuts are listed on the menu. See the list of current
Linux, Mac OS X, and Windows shortcuts.

You can also use the keyboard arrow keys to move the insertion point from one math construct to
another. The right and left arrows move the insertion point according to the structure of the mathematical
expression. For example, in a fraction when the insertion point is at the end of a numerator, the right
arrow key moves the insertion point to the beginning of the denominator. Moreover if you use the right
arrow to a construct that is not already completed, the insertion point is directly moved to the nearest
placeholder.

14.2. Advanced editing features
14.2.1. Entering Math characters
When you type a character string in a MathML element, Amaya parses the string and automatically
generates the elements mo (operator), mn (number), mi (identifier), and mtext.

For example, to enter the formula x = 2a + b

1. If you are not in a mathematical expression, choose Insert a formula from the Insert/Math
submenu.
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2. Type this sequence of 6 characters: x=2a+b

Use the Structure or Source view to display the following structure generated by Amaya:

<mi>x</mi><mo>=</mo><mn>2</mn><mi>a</mi><mo>+</mo><mi>b</mi>

If the result is not exactly what you want, select the characters that were misinterpreted and change their
type with one of the commands such as Plain text (mtext), Identifier (mi), Number (mn), Operator
(mo) or Space (mspace).

14.2.2. The row construct
The row construct from the palette is the equivalent of the braces in LaTeX: it allows you to give
informations about how the different part of a formula are grouped together. It does not appear on the
screen but have an indirect effect on the rendering.

For instance, when entering brackets as in the following expression:

f (x) = 1
x

typing the sequence f(x)= ... would lead to:

f (x) = 1
x

Here, the (x) must be contained in a mrow element. You can correct the problem by selecting this part of
the formula and then clicking on the row construct. You can also directly get the expected mrow if you
choose Parentheses from the Insert/Math submenu or select the button in the Math palette.

14.2.3. Spacing
Amaya takes care of spacing within math expressions, but in some cases you may need to add some
additional space. Move the cursor to the position where you want to insert space and choose Space
(mspace) from the Insert/Math submenu. This creates a default horizontal space. You can then change
its width attribute to adjust its size or you can add other attributes (height, depth, linebreak) to
change vertical spacing. Refer to the MathML specification for more details.

14.2.4. Special characters
You can use the Character command from the Insert/Math submenu to enter mathematical characters
and symbols that are not available on the keyboard. Type in the name of the character, as defined in the
MathML specification. You may choose to type the Unicode value of the character instead. For entering
this value in decimal, start with a '#'. For entering the value in hexadecimal, start with '#x'. To type faster,
you can also enter the hexadecimal value without any leading '#x', but note that this may be ambiguous
(like 'af', for instance). In case of ambiguity, the string is interpreted as a character name.

You can also use the Special characters tool. In this tool, the pull-down menu allows you to choose a
group of characters, which are then available in the table below. Click a character in this table to insert it
in the formula or anywhere else in the document.

Also, the MathML specification recommends to add invisible characters in order to make it easier for a
speech synthesizer to read a formula. These characters are automatically inserted from the palette, but
sometimes you have to do it by yourself. You can then use the Insert/Math submenu or shortcuts. The
three invisible characters are:

1. invisible times: ab

2. apply function: f (x)

3. invisible comma: ai j
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14.2.5. Changing the structure
You may want to change the structure of an existing expression, such as appending a superscript, putting
parentheses around an expression, or turning an expression into the numerator of a fraction. To do that,
select the expression and enter the new construct with the Math palette, the Insert/Math submenu or the
keyboard.

You can also use Transform from the Tools menu. Select the expression you want to transform and
Transform will display a menu with all possible changes. For constructs that are not part of the
Presentation MathML markup - i.e. only available from the palette - clicking on the button will put the
selected expression in the most natural placeholder.

Changing an expression is useful to keep a recursive structure even when you enter a formula linearly.

For instance to enter
x2 ≤ 9

25 ⇒ x ≤ 3
5 you can,

• either enter "recursively" (faster but less natural for long expression) :

⇒ ≤ ⇒ ≤ ⇒ x ≤ ⇒ x2 ≤ ⇒ x2 ≤ ⇒ x2 ≤ 9 ⇒
◦ ...

• or enter "linearly" (you write as you read, but you need to select several times) :
x x x2 x2 ≤ x2 ≤ 9 x2 ≤ 9

◦ ...

Generally, you will use both methods.

14.2.6. Viewing structure in MathML
A MathML structure in a document can be viewed by choosing Show Structure from the Views menu.
Choosing this option opens up the Structure view, which reveals the main structure of the document, the
math elements, and their contents.

Math expressions can be edited in the main view or in the structure view.

The structure view is especially helpful to avoid ambiguity. For example, in the equation below, placing
the cursor after character b, it is not clear whether you wish to add something within the square root or
after it.

x = √a + b + 1

Selecting (or checking) in the Structure view avoids any misselections. You can also check the status line
at the bottom of the window.

14.2.7. Linking in MathML
You can create and use links in mathematical expressions. These links are represented using the XML
Linking Language (XLink). Only simple unidirectional hyperlinks are available in Amaya, but you can
associate a link with any part of a formula. For example, the fraction in the formula below is a link to the
W3C home page:

y = 1

√x2 + 1

Double-clicking or right-clicking any character within the fraction loads the W3C home page.

To create such a link, select a math expression (the fraction in the above example, for instance by
clicking on the fraction bar), click the button from the Elements tool, or choose Create or change
link from the Links menu, and click the desired target.
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If the target is an expression in a formula, you must first turn the expression into a target. Select the
expression and choose Create target from the Links menu to create an id attribute for the target
expression.

14.3. More about MathML
14.3.1. Browsers compatibility
Several browsers support MathML:

• Internet Explorer with the MathPlayer plugin

• Firefox and other Gecko-based browsers

• Opera since version 9.5

It is necessary to use the .xml suffix to be sure that XHTML documents are managed as XML. Without
this suffix some browsers do not display correctly documents that include mathematical expressions. It is
also recommended to use the utf-8 charset for all XML documents.

By default Amaya adds the XHTML 1.1 plus MathML 2.0 doctype at the beginning of the document.
This doctype is not mandatory but it is useful:

• to validate the document,

• to generate alphanumerical entities (like &int;) for mathematical symbols in the source code.
Otherwise mathematical symbols are coded like any other unicode character.

Unfortunately, this doctype is not supported by many browsers. So it could be necessary to remove this
doctype with the Amaya command: Tools/Change doctype/Remove the doctype.

IE uses the pmathml.xsl transformation style sheet and a plugin to display the MathML code included
in XHTML documents. Amaya adds automatically a link to that transformation style sheet, but the author
must store a copy of this style sheet (pmathml.xsl) in the local directory of the document.

14.3.2. Known issues
• Amaya implements only the Presentation part of MathML 2.0, not the Content Markup part.

• A few Presentation tags are not entirely available: mglyph, maction

• All presentation elements and attributes are available, but only the following attributes are
rendered on the screen: display, alttext, mathvariant, mathsize, mathcolor,
mathbackground, fontsize, fontweight, fontstyle, fontfamily, color,
linethickness, numalign, denomalign, bevelled, notation, lquote, rquote,
lspace, rspace, largeop, movablelimits, subscriptshift, superscriptshift,
form, width (mspace only), height (mspace only), depth (mspace only), align,
rowalign, columnalign, frame, framespacing, displaystyle, side, rowspan,
columnspan, rowspacing, columnspacing, rowlines, columnlines.

• The class, id, and style attributes are available, with the same semantics as in (X)HTML:
you can associate CSS styles with MathML elements (class and style attributes) and a
MathML element can be the target of a link (id attribute).

• Amaya uses the STIX fonts to render mathematical symbols, but currently not all symbols are
supported.
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15. Editing SVG graphics
Amaya enables you to include vector graphics in web pages, following the Scalable Vector Graphics
(SVG) specification. The goal is not create all SVG elements and attributes, but to implement a subset of
the language that is sufficient for the drawings that scientific authors include in their documents.

Amaya handles SVG elements as structured components, in the same way as HTML elements.
Therefore, you can manipulate SVG graphics in the structure view as you manipulate other parts of
HTML documents.

All editing commands provided by Amaya for handling text are also available for handling graphics.

Warning: SVG authoring is under development. You may find bugs and the user interface may
change in the future.

15.1. Creating graphics
To draw graphics, you need a SVG canvas. The canvas can be either the document itself or a <svg>
element inside a XML document. A SVG document is created by the File->New->New Drawing
command. A tab of the Elements tool allows you to create a SVG canvas and graphic components inside
a XML document.

When the user asks the creation of a SVG canvas into a XML document, Amaya looks for a place around
the insert point where such a <svg> element can be inserted. The element is created with a default width
and height. Later, when the SVG canvas is selected, the user can resize it.

If the user tries to create a graphics outside a SVG canvas, a <svg> element is automatically generated to
include the new graphic component.

When the user clicks within a SVG canvas, the SVG tool is presented and the user can create graphic
components:

• connectors: line, simple or double arrow, zigzag.

• text, embedded HTML fragment (foreignObject), mathematic formula, image.

• basic shapes: square, rectangle (optionally with rounded corners), diamond, parallelogram,
trapezium, triangles, circle, ellipse.

• polygon, polyline, open and close Bézier curves.

• regular polygons: pentagon, hexagon, heptagon, octagon, various stars

• 3D objects: cube, parallelepiped, cylinder, octahedron, pyramid.

• special symbols for electronics, chemistry, etc.

In formatted view, the position and size of all these created components are indicated by direct
interaction:

• For connectors (except for lines), basic shapes and 3D objects, you first select the position of
the left corner by pressing the left mouse button. While holding down the button (drag), move
the mouse to the position of the opposite corner, then release the button.

• For text and foreignObject, click on the position where you want to insert the element.

• For polygon and polyline, you click to generate a point at the corresponding position with the
left mouse button. To indicate the last point, use a double-click. A right click or a Esc stops the
interaction without an additional point.

15. Editing SVG graphics

49

http://www.w3.org/TR/svg/


• Fo Bézier curves, you process the same way as polygons except that you need to indicate the
direction of the tangents too.

When a line, an arrow, a polygon or a polyline is created the shift key may be hit to force an
approximation of 15°.

When the selection is in structure view, components are created with default position and size.

15.2. Selecting graphics
In formatted view, the rules to select graphics are the following:

• If the component is hollow then you need to click on outlines. Otherwise you can click inside it.

• If a polyline or a path is selected, then its control points are shown and can be selected
individually. If the selected control point is part of a segment of a Bézier curve, then the
corresponding Bézier handle is displayed.

• If the shift key is pressed, then each new element you click on is added to the selection.

• Several components can be selected at the same time, using the rectangular selection tool of the
SVG panel.

• When components are grouped, these components cannot be selected individually in the
formatted view. Only the group can be selected. But you may select them in the structure view.

15.3. Applying transformations to graphics
To apply transformations to a component, you must first select it. Available transformations are proposed
in the SVG tool but also in the contextual menu displayed with the right click.

Possible transformations are:

• group/ungroup components

• changing the level of components, to control overlay: send to back, one level down, one level
up, bring to front

• rotating

• vertical and horizontal symmetry

• scaling, skewing

• aligning components: left, center, right, top, middle, bottom. If only one component is selected,
the alignment is made according to the SVG canvas.

• distributing and spacing components

15.4. Styling graphics
You can change some style attributes of graphic components at any time with the Style panel. When a
SVG component is selected, the Style panel changes to display specific style attributes:

• Opacity controls the global opacity of the graphic component (fill and stroke)

• Fill controls the fill color and its opacity
◦ If the entry is not checked, the graphics is hollow
◦ The colored button displays the current color
◦ The palette button allows one to select another color

• Stroke controls the stroke color and its opacity
◦ If the entry is not checked, the graphics doesn't have outlines
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◦ The colored button displays the current color
◦ The palette button allows one to select another color
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16. Editing XML documents
16.1. Loading XML documents
Amaya can display any well formed XML document and can format it if there is an associated CSS
stylesheet.

For an XML document that refers to a not-supported DTD or namespace (different from XHTML,
MathML and SVG), Amaya offers a limited support for the display and for the edition. Indeed, as Amaya
does not analyse the associated DTD, it can not chack the validity of any XML document and can not get
specific information about elements and attributes and about their organization within the document.

16.2. Using style in XML
If the document is associated to a DTD that Amaya does not understand, the content of the document is
formatted and displayed in a way that reflects the structure of the document. If there is no style
indication, the content of each element will be shown as a block. However, for clarity, the elements that
contain at least a character string are considered to be inline and are displayed accordingly. Amaya can
associate a CSS style sheet. You can also modify the presentation of the document if you associate a CSS
style sheet to it by means of a xml-stylesheet PI (processing instruction).

16.3. Editing XML documents
Generic XML documents editing in Amaya is still experimental. For the supported samples (XHTML,
SVG, MathML), editing follows the same rules as for the corresponding document type. For the other
elements, only the Enter command is available in this version :

• If the selection is within an element, Amaya splits the selected.

• If a whole non-empty element is selected, Amaya creates a new element with the same type next
to the selected element.

• If a whole empty element is selected, Amaya creates a sibling for the parent of the selected
element with the same type.

You can also edit your XML documents in the Source view and use the File / Synchronize command.
Your modifications are then displyed in the formatted view.
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17. Styling documents
The Format menu enables you to change the appearance of your documents using cascading style sheets
(CSS)

17.1. Applying/Removing a theme
Amaya provides by default two different themes (Classic, Modern) that allow you to style the current
document.

To change the document presentation with a theme:

• Select Classic or Modern in the theme list proposed by the Style tool,

• or select Classic or Modern in the Format/Theme submenu.

To remove the current theme:

• Select No theme in the theme list proposed by the Style tool,

• or select No theme in the Format/Theme submenu.

All these changes can be undone (Edit/Undo or Ctrl-z).

When a theme is applied to a document, Amaya generates a style element whose content comes from
Amaya/config/Classic.css or Amaya/config/Modern.css files. You can create your own
Classic.css and Modern.css files in the AmayaHome directory. If you do so, Amaya will use them
instead of default config files.

17.2. Applying specific style
Some styles properties like color, background color, font, alignment, line spacing, or indent may be
applied to a piece of text or to a whole element using either the Style tool or one of the submenus of the
Format menu.

To apply a specific style:

1. Select a piece of text or an element.
To select an element, click within the element, then use the F2 key until the bottom line of the
window displays the type of the element in the first position. You can also use the structure
view to select an element.

2. Choose the right entry within the Style tool or in the Format menu.
The Style tool provides two buttons for for each color you may set (the text color and the
background color). The first button allows you to apply its current color; the second button
allows you to choose another color and to apply it.

To remove a specific style:

• The Style tool does not allow you to remove specific style. You have to use the No color or
Default entries of the Format submenus.

• In the Advanced editing profile, you can directly edit the attribute style.

17.3. Associating a class to an element
All values available for the class attribute in the document are listed in the Apply class tool.

To apply a class to an element:
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1. Choose the value in the Apply class tool.

2. If you want to select the class applied to another element, you have to select this element, then

click the button. The Apply class list is refreshed and the class used by the selected element
is highlighted.

3. Select a piece of text or an element.
To select an element, click within the element, then use the F2 key until the bottom line of the
window displays the type of the element in the first position. You can also use the structure
view to select an element.

4. Click the button to apply the class to the current selection.
If a piece of text is selected, Amaya generates a span element to enclose the current text and the
class attribute is attached to this new span element.

To associate a class with an element, you can also use the Attributes tool (advanced profile only). This
tool also enables you to delete a class attribute from an element or to change it (the class attribute is
handled like any other attribute).

To remove the class of an element:

• You can edit the class attribute in the Attributes tool.
When the element is selected, click on the [X] of the entry to remove the class attribute, or

click on the entry and edit its value then confirm with the apply button.

• You can also remove or edit the class attribute in the structure view.
To remove the class attribute, click in the value, F2 lets you select the whole value, then hit the
Delete key twice.

17.4. Using HTML style elements
Two submenus of the Insert menu enable you to add HTML elements that change the style of text:
Information type and Character element.

17.4.1. Information type elements
The Information type submenu lists HTML elements that define abstract styles.

To apply an information type:

1. Select a character string in your document.

2. Choose an option from the Information type submenu.
The selected character string displays in the chosen style.

Five of these Information elements are also available in the Elements tool: emphasis ( ), strong (

) code ( ), insertion ( ), and deletion ( ).

17.4.2. Character elements
The Character element submenu of the Insert menu provides another set of style elements.

To apply a character element:

1. Select a character string in your document.

2. Choose an option from the Character element submenu.
The selected character string displays the chosen style.
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Two of these Character elements are also available in the Elements tool: superscript ( ), and subscript (

).

17.4.3. Removing information type or character elements
All commands of the submenus Information type and Character Elements are cancelled when you
apply them twice.

To remove a style element:

1. Select the character string for which you want to remove the particular style.

2. Reapply the command from the Information type or Character element submenu of the

Insert menu, or use the buttons in the Elements tool: emphasis ( ), strong ( ), code (

), insertion ( ), and deleltion ( ), superscript ( ), and subscript ( ).

If you want to insert normal text (i.e. without any style), within a styled character string, put the insertion
point at the desired position, and activate the command corresponding to the style you want to remove
(in the Information type or Character element submenu of the Insert menu, or use the buttons in the
Elements tool).

17.5. Using the style editor
Note: The style editor is not available in the Amaya Lite editing profile.

The Style editor entry in the Format menu, or the button in the button bar, enables you to create a
list of CSS style properties through a dialog box with 4 different tabs: Characters, Colors, Boxes, Format.

When a set of properties is set, you can Apply them to the current selection:

• If the selection is within a formatted view, Amaya generates a style attribute on the current
element, creating a span element if only a character string is selected.

• If the selection is within the source view, or a within a CSS file, Amaya generates the CSS
syntax for the chosen properties at the current position.

In any case image paths included in the list of properties (background-image, list-style-image) are
transformed into paths relative to the selected document.

17.6. About linking external and user style sheets
Note: These actions are not available in the Lite profile.

A document can link to several external style sheets that are downloaded with the document and applied
to it.

An external style sheet can apply to multiple documents. When the same style sheet applies to several
displayed documents, Amaya downloads only one instance of the style sheet.

You can define a specific style sheet that applies to all documents downloaded on your system. This style
sheet is called the user's style sheet. It is stored in your local environment, in the AmayaHome directory as
the local file amaya.css.

For example, if you prefer to display documents in Helvetica on your screen and print them in small size,
you can create a user's style sheet with following CSS rules:
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@media print {
body {font-size: 10pt}

}
@media screen {
body {font-family: Helvetica}

}

17.6.1. Handling external CSS style sheets
The Format/Style sheets submenu provides a set of commands which enable you to control external and
user's CSS style sheets.

• Select Link to link a new CSS style sheet to the current document.
This command shows a dialog box.

◦ If the target CSS style sheet is displayed in another Amaya window and you want to
select it by clicking, activate the Click button then click anywhere within that window
to create the link.

◦ If the target CSS style sheet is displayed in another tab and you want to select it by
clicking, activate the Click button, then change tab and click anywhere within the
target CSS style sheet to create the link.

◦ If the target CSS style sheet is a local file you can use the Browse button to select it.
◦ Otherwise, type in the URI (like http://www.w3.org/file.css) of the target CSS style

sheet and then Confirm to create the link.

• Select Open to open a CSS style sheet applied to the current document.

• Select Disable to remove the effect of a CSS style sheet from the current document. This
command does not change the CSS link in the document. It simply ignores it.

• Select Enable to reapply a disabled CSS style sheet to the current document. This command
does not affect the CSS link in the document.

• Select Remove to remove an external CSS style sheet. This command is similar to the Disable
command, but it also removes the link that attaches the external CSS style sheet to the
document.

The Open, Disable and Enable commands can be applied to the user's preference style sheet, but the
Link and Remove commands apply only to external CSS style sheets.

The List of style sheets tool displays the list of style sheets applied to the document. It also lets you
link/remove, disable/enable, and open style sheets.

17.7. Showing applied style
When multiple style sheets are attached to a document, it is ofen difficult to understand why an element
is displayed with certain style properties. To help you in this situation, Amaya provides the Format/
Show applied style command that displays all the CSS style properties applied to the first selected
element.

You can then display the CSS rule that generates each property by double clicking on the property. As
long as the CSS properties window is open, Amaya updates its content when the selection changes.

By hitting F2, you can see the CSS properties applied to enclosing elements. When you change the
selection by clicking an element in the path of the status bar, displayed at the bottom of the window, CSS
properties are updated too.
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17.8. Creating a generic style for an element or a class
When a style attribute is associated with an element, you can use that element as a model for creating
or modifying a style rule by using the Format/Create rule command.

To create a generic style for an element or class:

1. Select the element you wish to use as the model. By default the selection is set to the character
string, and you have to press the F2 key to select the enclosing element.

Note: You must select only one element and this element must have a style attribute.

2. Choose Create rule from the Format menu. Amaya opens a dialog displaying a list of CSS
selectors. This list contains all classes that are defined for the current document (including those
defined in the linked CSS style sheets), as well as the element type to which the style is
associated.

3. Choose a selector in this list or enter a new class name and click Confirm.
The style of the selected element is then associated with the chosen selector and the style
attribute is removed from the selected element. Its value is moved to the style element, in the
document head, and all elements matching the selector are displayed with the new style.

When a new class is created with command Create rule, this class is automatically added to the list of
the Apply class tool.
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18. Searching and replacing text
You can search and replace text with the Search dialog by choosing Find from the Edit menu or

clicking the Search button . You can also use the keyboard shortcut: Ctrl-f.

This dialog enables you to search or replace text using different criteria:

• You must enter the character string for which you want to search in the Search for field.

• If the Ignore case button is selected, a case-insensitive search is performed; otherwise, the
string is searched for as it appears within the Search for field.

• Strings can also be replaced using the same operation. Enter the replacement text in the Replace
by field and select a replacement mode from the Replace box. The replacement modes are:

◦ No replace: No replacement occurs even if the Replace field contains a character
string.

◦ Replace on request: When the searched string is found, Amaya selects it. You can
then click one of the following buttons:

▪ Confirm to replace the selected string and carry out the search again.
▪ Do not replace to search for the next instance without replacing the string

that was found.
◦ Automatic replace: All instances of the searched-for string are automatically replaced

within the portion of document defined in the Search where box.

• The Search where box enables you to specify the part of document in which the search occurs:
◦ Before selection: The search starts at the beginning of the selected part and moves

backward to the beginning of the document.
◦ Within selection: The search only occurs within the selected part, from its beginning

to its end.
◦ After selection: The search starts at the end of the selected part and moves forward to

the end of the document.
◦ In the whole document: The search is carried out in the whole document from the

beginning to the end regardless of which part is selected.

To initiate the search operation, click the Confirm button at the bottom of the dialog box. If Amaya finds
the searched-for string, it is selected and the document is positioned so as to make this string visible. You
can then search for the next instance of this string by clicking the Confirm button again. If the string is
not found, Amaya displays a "Not found" message next to the Confirm button.

Search or replace can be abandoned at any time by clicking the Cancel button.

Replacement operations can be undone by choosing Undo from the Edit menu, or by using the keyboard
shortcut Ctrl-z.
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19. Checking spelling
Amaya provides a multilingual spell checker and selects the appropriate language according to the lang
attribute. The lang attribute can be associated with any element in a document, even with a single word,
using the Attributes tool.

To spell check a document, choose Check spelling from the Tools menu.

19.1. The personal dictionary
When you register a new word, the spell checker creates or updates the user's personal dictionary. A
user's personal dictionary is located in the AmayaHome/dictionary.DCT file. In read-write mode, the
spell checker uses the user dictionary when checking all documents, in addition to the language-specific
dictionaries. When you click the Learn button in the Spell checking dialog, the user dictionary is
created, if does not already exists, and automatically updated by the spelling checker.

19.2. The spell check dialog
The Tools / Check spelling command displays a dialog that enables you to choose parameters and
interact with the spell checker.

• The top left field displays an incorrect word. The list of proposed corrections is displayed in the
selector field located below the incorrect word. By default, Amaya selects the first proposed
correction. To select another correction, simply click it. The selected correction is displayed
below the selector field. This correction can be edited on there. The correction is made when
you click the Replace and next button.
Note that you can also perform the correction by double-clicking a proposed correction.

• The language in which the correction is made is specified in the bottom left corner of the
dialog. To change language, apply a lang attribute to the text with the Attributes tool, and
restart the spell checker.

• The Ignore section tells the spell checker to ignore certain words, for example, words that
contain only capital letters, words that contain digits, Roman numerals or words with special
characters (you can choose the special characters).

• The Checking section, similar to that in the Search dialog, enables you to specify the part of
document on which the checker will work.

19.3. Running the spell checker
Before running the spell checker, make sure the current selection is in the document you want to check.
For the spell checker, the source code is different from the formatted document. If the current selection is
in the source view, all the markup will be checked, including tags, attributes, etc. If the selection is in the
formatted view, only the content of the document will be checked.

To start the checker, click the Search/Skip button at the bottom of the dialog. If an error is found, the
incorrect word is selected and highlighted in the document. If no error was detected a message "End of
spell checking" is displayed at the bottom of the dialog.

When an incorrect word is detected, you can use a button on the dialog to perform the following
operations:

• Search/Skip: The incorrect word is acceptable. No change is made in the text or in the
dictionaries. The checker searches for the next error.
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• Learn: Performs the same action as the Search/Skip button, except that the word considered
incorrect is added to the user's personal dictionary, and the checker will ignore any subsequent
occurrence of this word.

• Replace and next: Amaya replaces the incorrect word with the correct word (optionally edited)
and the checker searches for the next error.

• Close: Amaya closes the dialog box and stops spell checking. Previous corrections are not
canceled.
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20. Saving and publishing documents
You can save (X)HTML documents either in (X)HTML or as plain text. Other documents (SVG,
MathML, XML or CSS) are saved according to their original format. You can save both remote and local
documents with three different commands, Save, Save as, and Save all.

In addition, you can change a number of publishing options using the Publishing Preferences dialog.
Open this dialog by choosing Preferences / Publishing from the Edit menu (or amaya / Preferences on
Mac OS X).

Amaya does not provide any global view of a set of pages installed on a server. However, you can save
files from a remote server in the same way you save local files, using the Save as commands. During
these operations, Amaya can also save the resources you have associated with the document (images,
style sheets, scripts).

20.1. The save command
The Save command saves the current document to its original location, be it local or remote. You can

access the Save command by choosing Save from the File menu, clicking the Save button on the
button bar, or by using keyboard shortcuts Ctrl-s. Newly added images are saved in the same directory
automatically; confirmation is only requested when the document was downloaded from a web server
and its name is unknown.

You can also fetch a document from web servers by specifying only the server directory name, but not
the file name. This may be useful when browsing, but a file name is required by the HTTP Put method.
In this case, Amaya detects that the document name is missing and asks you either to use a default name
or to provide one.

Note: Use the Save As command to save your document to a different location.

20.2. The save all command
The Save all command allows you to save all documents open in Amaya that have been modified and
not saved yet. It works exactly like the Save command, but for all the modified documents, not only the
current one.

This command may be called from the File menu or by clicking the button on the button bar.

20.3. The save as command
Choosing Save As (Ctrl-Shift-s) from the File menu opens the Save As dialog, which allows you to
save the current document with a different format and to a different location.

You can:

• save the document alone or with its resources (images, objects, style, scripts) to a local disk or
to a remote web server;

• embedded images and objects can be saved into the same directory as the document or to a
different location;

• embedded style (including imported style sheets and images) and scripts can be saved into the
same directory as the document or to a different location;
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• all URIs used in the document can be updated to take into account the new location of the
document and its associated resources.

The dialog box contains two tabs and two buttons. The first tab is about the document itself. The second
tab is about its associated resources (images, styles sheets, scripts).

The Document tab contains:

• The Document location field indicates where the document file has to be written. This can be
in the local file system (for example, /pub/html/welcome.html) or a remote URI (for
example, http://www.w3.org/pub/WWW/Welcome.html).

Note: Usea complete path for the URI. You should also make sure that you have the rights to
do a PUT method if it is a remote location. Refer to the page on configuring your server to
accept the PUT method or ask your Web administrator.

• The Document format menu offers a choice between HTML, XML (XHTML) and Text for
HTML documents. This submenu is not shown when saving a SVG, MathML, CSS, or XML
document. By default, Amaya keeps the current document format.
Entry Text removes the HTML mark-up and produces a plain text document.

• Options menu:
◦ The Transform URLs toggle transforms all current URIs into relative URIs when

possible. Of course, if the document is saved in a local file and URIs point to remote
files, URIs will be absolute. This ensures that all the links in the document are
preserved by the copy.

If you save the document locally to publish it by ftp just because your provider or your
Webmaster does not allow you to use the HTTP Put method, you must disable this
option to not alterate links computed when the document was on the http server.

◦ The Copy Images toggle indicates whether the images and objects embedded in the
current document must be copied along with the document to a new location. You have
to keep this switch on when you want to generate a complete copy of the document.
When images and objects are copied, Amaya updates automatically all src and data
attributes to point new locations. New locations are relative URIs.

◦ The Copy resources (styles and scripts) toggle indicates whether style sheets
(including imported style sheets and images) and scripts embedded in the current
document must be copied along with the document to a new location. You have to
keep this switch on when you want to generate a complete copy of the document.
When these resources are copied, Amaya updates automatically all links and
processing instructions to point to these new resource locations. New locations are
relative URIs.

• The Charset field allows you to choose the charset of the document. This option only works
with documents that support the notion of charset, such as HTML and XML documents, but it is
not proposed when saving from the source view. This option is available when saving both
remote and local documents.

Very often the charset of Web documents is controlled by the server. It depends either on the
document suffix (html, xml, xhtml, svg, mml), or on instructions given in the .htaccess file.

• The Mime Type field allows you to select the MIME type of the document. If the MIME type
you are looking for is not listed, you can type it in yourself. This menu is only active when
saving a document to a remote web server (local file systems do not store the MIME metadata
information).
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The Images, Styles and Scripts tab contains:

• The field Where to save images allows you to specify the directory where images and objects
have to be saved. This may be a directory on a remote web server. When the Copy Images
button is selected, this field is initialized with the directory of the saved document.

• The field Where to save resources allows you to specify the directory where style sheets and
scripts have to be saved. This may be a directory on a remote web server. When the Copy
resources (styles and scripts) button is selected, this field is initialized with the name of the
saved document directory.

Two buttons complete this dialog:

• The Save button starts the process of saving the document. If you have chose to save associated
resources too, a list of these resources is displayed and you can choose to remove some
resources from the list: they will not be saved.

When saving to a remote location, check that the http_proxy is not set, or that the proxy server
and the target server are configured to work with the HTTP Put method.

• The Cancel button terminates the command without doing anything.

20.4. Saving and characters encoding (charset)
Three standard encodings are considered:

• us-ascii is a 7-bit code that represents 96 printable characters (positions 32 through 127
decimal).

• iso-8859-1 is a 8-bit code that represents the same characters as us-ascii, at the same
positions, plus 95 additional printable characters, commonly used in various European
languages.

• utf-8 is a variable length encoding scheme for the Universal Character Set - UCS (ISO10646
aka Unicode). UCS represents thousands of characters. Note that the 96 first characters have the
same positions in UCS as in us-ascii (and then as in iso-8859-1).

If an XML or HTML document contains a character that is not available in the character set (charset)
available with the encoding, a special representation is required. XML offers two such representations of
characters:

1. Character references represent the position (in decimal or hexadecimal) of the character in the
UCS. For example, the greek letter α (alpha) is represented as &#x3b1; (hexadecimal) or
&#945; (decimal)

2. Entity references use a name to represent a content (in that case a character). For example the
greek letter α is represented as &alpha;

Character references may be used in any XML or HTML document, but entity references are allowed
only if the document itself contains a means to resolve the name.

Entity name resolution is provided by the Document type definition which refers to the DTD where
names and their associated contents are defined. Practically, this means that you can use entity references
only if the <!DOCTYPE ...> is present and refers to a DTD that defines the names you use.

By default, Amaya preserves the initial encoding of the document, that is the encoding that was
associated with the document at loading time. You can check this encoding with command Views/
Document info (Charset field). The Save and Save all commands save the document with that
encoding, while the Save As command allows you to choose another encoding (Charset field).
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When saving a document (Save, Save all, or Save As commands), all characters that are available in the
charset of the encoding are just written using the encoding. Only the other characters are written using
character or entity references. The choice between these two options is made according to the doctype.
If there is a doctype that refers to a DTD that defines a name for the character, an entity reference is
used (i.e. a name), otherwise Amaya generates a character reference in hexadecimal.

Note: command Tools/Change doctype allows you to associate, to change or to remove the doctype of
a document at any time. This allows you to make Amaya generate either character references or entity
references.

20.5. Saving documents as text
You can save your document as plain text using the Save as command from the File menu. HTML mark-
up is replaced by spaces, new lines, and so on. A list of all URIs used in the document is appended to the
file.

To save your document as text:

1. Choose Save as from the File menu to open the Save as dialog box.

2. Click the Text button in the Document format section to save the document in text format.
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21. Cooperating through WebDAV
21.1. About WebDAV
WebDAV (WWW Distributed Authoring and Versioning) is a set of extensions to the HTTP protocol,
which allows users to collaboratively edit and manage web resources on remote servers. It aims to extend
the HTTP protocol to develop new distributed authoring tools in the web, specially emphasizing the
collaborative authoring of web pages.

The lock mechanism defined in WebDAV has been design to prevent the resources overwriting (that is,
to prevent the lost update problem) using the operations lock and unlock. A lock controls the write access
to a resource by limiting HTTP writing operations, like PUT, POST and DELETE. This means that only
somebody who knows the lock will be able to execute those operations. The WebDAV protocol also
defines two lock scopes: an exclusive and a shared lock. An exclusive lock guarantees that one person
possess the lock, and no one else will be able to lock the resource (it does not affect the resource
reading). A shared lock allows a group of users to create their locks over a resource, but they must trust
each other to prevent access problems. Besides, each lock has a timeout, but the user cannot forget that
locks may disappear in the server due to exceptions in the server.

You can find more informations about WebDAV in RFC 2518 and also at the WebDAV.org website.

21.2. WebDAV support in Amaya
Amaya has an optional and limited support for WebDAV. This includes the following operations: lock/
unlock a WebDAV compilant resource, view the WebDAV properties of a resource, and lock discovery
capabilities. Besides, it also includes some awareness functions, that can automatically inform users
about locked resources.

21.3. Sharing documents
The WebDAV support present in Amaya intents to help small groups of users to edit collaboratively their
web pages. To illustrate how it works, here is an example: supose that you have a WebDAV server
(indeed, you must have a Web server that supports WebDAV to work with it) named
davserver.mycompany.com, and you and your colleagues want to edit collaboratively some documents
that are in the WebDAV folder /shared/ (WebDAV folders are called collections).

So, imagine that you need to change the document http://davserver.mycompany.com/shared/
Doc1.html. To do so, you load the document in your Amaya editor, and then you can lock this document
(Lock resource entry in Tools/Cooperation menu. Once you locked the document, if one of your
colleagues tries to save some change in this document, s/he will be warned about your lock, and updates
will not be lost automatically. Thus, while the document is locked, you can safely modify it, and when
you have finished your work and saved the document, you can unlock it, allowing you colleague to lock
the document and do his/her modifications.

If you want to be aware whether a colleague has locked a Web page, you can use the View resource
properties entry in the Tools / Cooperation menu to see all the properties of the page, or you can
configure Amaya to automatically inform you if the page is locked. To do so, you will need to open the
Preferences / WebDAV dialog box, mark the General Awareness option and put your shared folder
name in the User's WedDAV Resource List field (http://davserver.mycompany.com/shared/, in
our example). Once you did this, when loading a page locked by a colleague under
http://davserver.mycompany.com/shared/ folder, you will be notified by Amaya about this.
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21.4. WebDAV options
The following options can be set with the Preferences / WebDAV dialog box. They are also available in
the Amaya registry:

User's personal reference (URL)

An URL that identifies the user. Example: mailto:myself@myhost.com or http://myhost.com/
myhomepage.html
Registry: DAV_USER_URL= [ URL ]

Lock Depth

If depth is infinite, a lock over a collection (folder) will affect all components. Otherwise, the lock
will affect only the collection, preventing an user that does not know the lock to create or remove
components.
Registry: DAV_DEPTH= [ infinity | 0 ]

Lock Scope

The lock scope: exclusive or shared.
Registry: DAV_LOCK_SCOPE= [ exclusive | shared ]

Lock Timeout

The desired timeout for the lock. "Infinite" means that there is no timeout value, and "Other
(Seconds)" will try to get a timeout value of x seconds (value x specified by the next field).
Registry: DAV_TIMEOUT= [ Infinite | Second-XXXX ]

General Awareness

Indicates if you want basic awareness information about locked resources
Registry: DAV_AWARENESS= [ yes | no ]

Awareness on exit

Indicates if you want to receive information about your own locks, when you leave a resource.
Registry: DAV_AWARENESS_ONEXIT=[ yes | no ]

User's WebDAV Resource List (URL URL)

A list of the URLs of the resources you use as WebDAV resources.
Registry: DAV_URLS= [ URL URL URL ... ]

21.5. Compiling Amaya with WebDAV
WebDAV support is an optional feature of Amaya. To compile and use it, you need the following:

• Libwww with WebDAV support

• Amaya's configure option

• A WebDAV server to use this functions... Jigsaw and Apache are examples of web servers that
support WebDAV.

Once you made the cvs check-out of Libwww with WebDAV support and get Amaya sources, you
should follow this bootstrap instructions (under Linux/Unix environments - for windows environments,
see Amaya and Libwww homepage):

21.5.1. At libwww folder:
• libtoolize -c -f

• perl config/winConfigure.pl
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• aclocal; autoheader; automake; autoconf

21.5.2. At Amaya folder:
• autoconf

• mkdir LINUX-ELF (or GTK, or obj)

• cd LINUX-ELF

• ../configure --with-dav ... (and all other options that you need)

• make
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22. Printing documents
Amaya can print documents with or without CSS style sheets, on both Linux and Windows platforms.

Important: On Linux platforms, Amaya can only generate a Postscript description, so you must have a
PostScript printer or use an application to translate the PostScript into your specific printer language.

You can print a document in three ways:

• Setup and print (File/Setup and print), which enables you to set some parameters and options
before printing.

• Print (File/Print), which prints a document using the current print configuration (defined using
the Setup and Print command).

• The button on the button bar. On Linux platforms, this is a shortcut to the Print
command. On Windows platforms, this is a shortcut to the Setup and Print command.

For more information on printing with style sheets, see section About controlling printing with CSS.

22.1. Using the Print command
This command prints the current document with the default printing parameters or with the values
previously set using Setup and print.

On Windows platforms, the first time you launch the Print command, the standard Windows dialog is
opened to check that the default printer is correct.

22.2. Using the Setup and print command
The Setup and print command allows you to change the printer and other options. Depending on your
operating system, some parameters and options are reset to their default value when you browse another
document.

22.2.1. On Windows platforms
On Windows platforms, the first time Setup and print is activated, a dialog allows you to make some
choices like:

• generate a table of contents for the document,

• generate a table of links for the document,

• print the document URL on top of each page,

• and print with or without style sheets.

The next times, or when the Print command is selected, the standard Windows dialog pops up, and
allows you to choose the other printing parameters.

22.2.2. On Linux platforms
Under Linux, the Setup and print command allows you to:

• set the paper format (A4 or US),

• set the orientation (portrait or landscape),

• choose the number of pages printed on the same sheet (1, 2, or 4 pages per sheet),

• choose the output (postscript file or printer).
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In addition, you can:

• select manual paper feed,

• generate a table of contents for the document,

• generate a table of links, which creates a number after each link in the document that refers to
an entry in the table of links and the corresponding URI

• print the document URI on each page,

• print the document with or without style sheets.

When the Print command is activated, printing is done with the standard options or the options previous
selected.

22.3. About controlling printing with CSS
Amaya does not print links as underlined. To make this happen, add the following line to your user style
sheet (the amaya.css file, located in your AmayaHome directory):

@media print {a:link {text-decoration: underline} ... }

Amaya supports the CSS page break property page-break-before: always. When you attach this
property to a specific element using a style attribute, Amaya generates a page break before that
element. When you attach this property to an element type within the style element of the document or
within an external CSS style sheet, Amaya generates a page break before each instance of that element.

Note: Some CSS properties are not well supported by the print process.
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23. Numbering sections
Section headings (h2 to h6 elements) can be automatically numbered to reflect the document structure.

The h1 element is supposed to be the document title and is not numbered. Other headings receive a
number that is computed according to their type and their position in the document structure. These
numbers are generated in the document itself and numbers that were generated previously are removed,
every time the Tools/Section numbering command is called.

24. Generating a table of contents
Command Tools/Add-Update table of contents collects all h2 to h6 elements in the document
following the current selection and generates a table of contents at the current position. It updates the
current table of contents if the selection is already within a table of contents.

This command adds:

• An id attribute to each h2 to h6 element which does not have this attribute.

• A division (with a class="toc" attribute) that contains nested unnumbered lists (ul) at the
current position. You can use the class attribute to set a particluar style to your tables of
contents.

• A list item (li) for each h2 to h6 element including a link which points to the corresponding
element in the document.
The link element contains a copy of the hn element. If the hn element is numbered, this number
is also copied.
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25. Assembling large document collections
Amaya enables you to handle document collections. Such a collection may, for example, represent a
technical documentation made up of several web pages. The present manual is a document collection.

One of the web pages in the collection contains the title of the entire documentation (an h1 element), an
introduction (some other elements), and a list ol or ul whose items li contain links to each chapter.
Chapters are separate documents that can have a similar structure.

This organization is useful for browsing, but has several drawbacks when the entire documentation has to
be printed.

Amaya addresses this problem with the Tools/Make book command, which assembles a document
collection into a single volume. You use typed links for linking chapters, by associating an attribute
rel="chapter" or rel="subdocument" with the anchor that refers to a chapter (create a link and use
the Attributes tool for the rel attribute).

Each referred chapter or sub-document may be:

• a full external document,

• a subset of a larger external document.

To refer to a document subset, you usually define a div element to identify the part of the document you
want to include, and you create a link to this div element.

Then, when you activate the Tools/Make book command, all blocks (li elements in the above example)
containing a typed link to a chapter will be replaced by the corresponding actual web pages (or a part of
it), and Amaya will display a unique document containing the whole collection:

• If the link refers to a web page as a whole, Amaya includes all the content of the body element
of the target document.

• If the link refers to an element in a web page, Amaya includes this element with its content.

• If the link refers to a target anchor (a element), Amaya includes the content of the anchor, but
not the anchor itself.

Before each replacement, the Make book command generates a new div element with an id attribute to
clearly separate each included piece.

Pieces of the new generated document may contain normal links, target anchors, and target elements.
During the Make book operation, Amaya ensures that each name and id attribute value remains unique
in the new document. Amaya changes these values ss needed, and updates all relative links.

Amaya automatically transforms external links referring to external documents or to document parts, into
internal links to the part that are now included. For example, if the link originally pointed to an external
document, the link will now refer to the div element generated by the Make book command. This
ensures that all links are preserved in the new unique document containing the whole collection.

This large document can then be numbered and printed with a complete table of contents and a list of all
links.
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26. Annotating documents
26.1. What is an annotation?
Annotations are comments, notes, explanations, or other types of external remarks that can be attached to
a Web document or to a selected part of a document. As they are external, it is possible to annotate any
Web document independently, without needing to edit the document itself. From a technical point of
view, annotations are usually seen as metadata, as they give additional information about an existing
piece of data. Amaya uses a special RDF annotation schema for describing annotations.

Annotations can be stored locally or in one or more annotation servers. When a document is browsed,
Amaya queries each of these servers, requesting the annotations related to that document. Amaya

presents an annotation with an icon that is visually embedded in the document. If you single-click
this icon, the text that was annotated is highlighted. If you double-clicks the icon, the annotation text and
other metadata are presented in a separate window.

An annotation has many properties including:

• Physical location: is the annotation stored in the local file system or in an annotation server

• Scope: is the annotation associated to a whole document or just to a fragment.

• Annotation type: 'Annotation', 'Comment', 'Query', ...

26.2. Local and remote annotations
Amaya can store annotation data in a local file system (local annotations) or it can store annotations
remotely, on annotations servers accessed through the Web (remote annotations).

You do not need a server to create local annotations. Local annotations are stored under your
AmayaHome directory, in a special directory called annotations, and they can be seen only by their
owner (according to the system access right setup).

This directory contains three kinds of files:

• annot.index: Associates URLs with the files containing the metadata of the annotations.

• index + random suffix: Stores the metadata of the annotations related to a given URL. The
metadata is specified in RDF.

• annot + random suffix.html: Contains the body of an annotation, stored as XHTML.

At any time, you can convert a local annotation to a shared one by choosing Post to server from the
Tools/Annotations submenu. Once this is completed, the local annotation is deleted because it has been
moved to an annotation server.

26.2.1. Remote annotations
You can store remote annotations in annotation servers so that the annotations can be downloaded by
anyone having the correct access rights, such as is the case of other HTML documents.

Remote annotations are referred to as shared or public annotations, because they can be seen by other
people. If you wish to install your own annotation server, please refer to Annotation-Server-HOWTO.

26.3. Creating an annotation
Before creating an annotation, it is recommended to set some parameters in the Preferences (see section
Configuring annotations).
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Amaya supports two kinds of annotations: annotations that apply to a whole document and annotations
that apply to a specific position or a selection in a document.

• To annotate an entire document, choose Annotate document from the Tools/Annotations
menu.

• To annotate a position, put the insertion point at that position in the document and choose
Annotate selection from the Tools/Annotations menu.

• To annotate a selection, make a selection in the document and choose Annotate selection from
the Tools/Annotations menu.

After these operations, an annotation document is displayed, with some inital metadata and an empty
body.

The metadata consists of the title of the annotation, the author's name, the title of the annotated
document, the annotation type, the creation date, and the last modification date.

Some of the metadata fields have special properties:

• The Source document field is a link that points back to the annotated text. If the user double-
clicks it, as when following any other link with Amaya, the annotated document will be
displayed with the annotated text highlighted.

• The Annotation types field lets you classify the annotation and change its type. Double-click
on the text Annotation type to see the list of types available.

• The Last modified field is updated automatically each time that an annotation is saved.

Below the header area is the annotation body area. It shows the current content and can be edited like any
other HTML document.

Some commands that can be applied to a document in the Amaya document window also can be applied
to an annotation document in the Annotation window. For example, the body of an annotation can be
printed by choosing Print from the File menu, or reloaded by choosing Reload document from the File
menu.

26.4. Saving an annotation
Saving an annotation is the same as saving any other document with Amaya: choose Save from the File
menu (or use its equivalent shortcut or button) or press the Save button.

Local annotations are saved to the annotations directory and remote annotations are saved to the
annotation post server, if the user has write access.

To convert a local annotation into a shared one, choose Post to server from the Tools/Annotations
menu to save the annotation to the Post server as defined in the Configuration for Annotations dialog.
If this operation is successful, the local annotation will be removed and future Save operations will go
directly to that annotation server.

26.5. Deleting an annotation
The Delete command on the Tools/Annotations submenu enables you to delete the current annotation.
You can invoke this command from an annotation window.

You can also delete an annotation from the annotated document. Select the icon of the annotation and
call the same command from the Tools menu in the annotated document window.
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26.6. Loading and presenting annotations
The Tools/Annotations/Load command tells Amaya to load the annotations that are associated with the
URL of the current document. Amaya will query the annotation servers, using the settings from
Preferences/Annotations, and ask for any relevant annotation.

Annotations may also be loaded automatically whenever a new page is viewed by selecting the Autoload
remote annotations check box in Preferences/Annotations.

Querying an annotation server returns all the annotations that are associated with a document.

26.7. Annotations in the Links window
The link view of the annotated document shows all the annotations.

As with the document window, annotations are identified by a pencil icon. A single-click on the icon
selects the annotated text in the document window and a double-click opens the annotation.

26.8. Replying to annotations / discussion thread
Annotations can be seen as comments to web pages. The Tools/Annotations/Reply to annotation
command enhances the collaborative workspace by allowing users to reply to annotations or to other
replies.

The Reply to annotation command of the Tools/Annotations submenu lets you create a reply to an
existing annotation or to a reply. You can invoke this command from an open annotation or a reply
window.

As a result a new annotation document opens. The fields in a reply annotation can be edited just like in
any other annotation as explained under Creating an annotation.

When the reply is ready, you can post it to a server with the Tools/Annotations/Post to server command
or you can save it locally using the File/Save command. To delete a reply, you can use the Tools/
Annotations/Delete command.

Replies can also be annotated like any other document, as explained in Creating an annotation.

All replies related to an annotation are shown at the bottom of this annotation, in a thread section. Each
item in the thread gives the date of the reply, the author, and the title of the reply.

The content of any of these replies can be retrieved by double clicking the replies in the thread. The
selected reply is highlighted and presented in a reply tab. When another selection is made the same reply
tab is used.

26.8.1. Known issues: incomplete thread
There is no way to control which replies should be posted. In an ideal world, it should not be possible to
save a reply to a reply if the previous reply was not saved in the same server. Likewise, if you delete a
reply, you should delete all replies to this annotation. Not doing that leads to having fragments of threads
that cannot be correctly attached in the thread.

For example, let R1 be the reply to annotation A1 and R2 a reply to R1. If you post R1, and let R2 be
stored locally, then when you browse A1 and only download its local annotations, you will only see R2.

At this point, Amaya does not know that R1 exists, so it assumes that R2 has lost its parent. We identify
these "orphan" threads by putting a question mark symbol ? in front of them. If later one, Amaya finds
new thread items, for example, if you download R1, Amaya will then sort the thread view, inserting the
threads as appropriately. In our example, R2 will become a child of R1, as expected.
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26.9. Configuring annotation icons
26.9.1. User-definable icons by Annotation type (aka "dynamic icons")
The icon used to mark the location of an annotation within an annotated document may be changed by
the user. The icon that denotes an annotation is chosen as a property of the annotation type. By including
an RDF property of each annotation type you wish to use, you select the icon associated with annotations
of that type.

The sample configuration associates the following icons:

Advice

Change

Comment

Example

Explanation

Question

SeeAlso

The property name for adding annotation icons is http://www.w3.org/2001/10/typeIcon#usesIcon. For
instance, to specify an icon named file:///home/question-icon.jpg for annotations that have type
http://www.w3.org/2000/10/annotationType#Question you would enter the following RDF/XML into a
file that Amaya reads at startup is:
<rdf:RDF

xmlns:rdf="http://www.w3.org/1999/02/22-rdf-syntax-ns#"
xmlns:i = "http://www.w3.org/2001/10/typeIcon#">

<rdf:Description rdf:about="http://www.w3.org/2000/10/annotationType#Question">
<i:usesIcon rdf:resource="file:///home/question-icon.jpg" />

</rdf:Description>
</rdf:RDF>

The simplest way to get such RDF loaded into Amaya at startup is to include the file in the config/
annot.schemas file in the Amaya program directory. In order to preserve this file so that it will not be
overwritten when you install a new version of Amaya, you should copy the config/annot.schemas file
into your personal AmayaHome directory.

You may list as many RDF files as you want in annot.schemas. See the comments in the file included
in the Amaya kit for more details.

A sample file named typeIcon.rdf declares unique icons for each annotation type declared in the
http://www.w3.org/2000/10/annotationType# namespace. To experiment with user-defined icons, it may
be easiest to copy this typeIcon.rdf into another directory and modify it. Copy annot.schemas to
your AmayaHome directory and change the line near the end to point to your revised icon definition file.

Amaya supports JPEG, PNG, and GIF bitmap graphics formats for icon images. The icon URI may only
be a file: URI; that is, the icon must appear in a local or mounted directory to Amaya. Two special forms
of non-file: URIs are supported. If the file path name starts with $THOTDIR or $APP_HOME then the
corresponding Amaya installation directory or personal Amaya home directory is substituted into the
pathname.
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26.10. Known issues with annotations and modified documents
When you use annotations with live documents (documents whose contents can be modified), you may
encounter two kinds of problems: orphan annotations and misleading annotations. To explain these
problems, we must first describe how Amaya attaches annotations to documents.

Amaya uses XPointer to indicate where an annotation should be attached to a document. XPointers are
based in the structure of the document. To build an XPointer for a selection, for example, Amaya starts
from the first point of the selection and walk backwards through the document's structure, until it finds
the root of the document. If an element has an id attribute, Amaya stops building the XPointer and
considers the element with the id attribute value to be the beginning of that XPointer.

For example, if you look at the HTML source for this document, you'll notice that this section is enclosed
within a div element that has an id attribute with the value "Issues" Here's an extract of the source code:

<div id="Issues">
<h1>Issues with ....</h1>
<p>If you are using...</p>
<p>Amaya uses <strong>XPointer</strong>...</p>
...
</div>

This XPointer points to the second paragraph: xpointer(id("Issues")/p[2])

The above XPointer points to the second p element, from the element parent having an id attribute with
value "Issues".

Note that the use of the id attribute enables the document author to move the entire reference by the
XPointer to another location within the document, without needing to update the XPointer. The XPointer
does not depend on the elements that precede it.

26.10.1. Orphan annotations
An annotation becomes an "orphan" when it can no longer be attached to a document, that is, when the
XPointer does not resolve to any element in the structure. This happens when a document's structure is
modified. Amaya displays a warning if it detects any orphan annotations while downloading a set of
annotations from an annotation server. All orphan annotations are visible from the Links view and are

associated with an icon that shows a question mark superimposed on the annotation pencil .

26.10.2. Misleading annotations
An annotation becomes "misleading" when it points to a wrong piece of information. This problem is
common when you annotate a portion of text that may change. In the first release, Amaya does not warn
the user if an annotation is misleading. A future release may notify users of the potential for an
annotation to be misleading.

26.10.3. What can you do to avoid this?
As the author of a document, try to use the ID attribute in strategic places, for example, inside <DIV> and
p elements. For example:

<p id="Amaya">Amaya uses...</p>

An XPointer that points to this paragraph is: xpointer(id("Amaya"))

Thus, the Xpointer will point to the same paragraph, regardless of its position in the document's structure.

Amaya enables you to automatically associate with or remove an ID attribute to/from a set of elements
by choosing Add/Remove IDs from the Links menu.
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27. Configuring Amaya
Amaya uses different configuration files to get initial values for global parameters, dialogs, shortcuts,
window size and position, user's style sheet, and so on. You can change most configuration parameters
through various preferences dialogs.

> 27.1. One or more instances of Amaya
By default only one instance of Amaya is allowed to run at a time. Each new invocation is redirected to
the running instance. This option can be changed by setting the environment variable
AMAYA_MULTIPLE_INSTANCES=yes.

> 27.2. Configuration directory and file conventions
Amaya uses a number of default directories to store configuration information.

27.1. The config directory
Amaya stores most of the default configuration files (fonts, shortcuts and preferences files,) and all of the
dialog messages in the config directory. This directory's parent is the one in which Amaya was installed.

Unix
Amaya/config where Amaya=binary_path/../..

(e.g. /usr/lib/Amaya/config)

Windows
$HOMEDRIVE:\$HOMEPATH\amaya

by default
C:\Documents and Settings\$user_name\Amaya\config

Mac OS X /Applications/Amaya.app/Contents/MacOS/Amayax.x/config

27.2. The AmayaHome directory
Amaya stores the user preferences and other user configuration files in a directory called AmayaHome.
An existing directory could be selected by the user using the system environment variable
AMAYA_USER_HOME. Otherwise Amaya selects a default position.

Default AmayaHome Directory :

Unix $HOME/.amaya

Windows
$HOMEDRIVE:\$HOMEPATH\amaya

by default
C:\Documents and Settings\$user_name\amaya

Mac OS X ~/Library/Application Support/amaya

This directory is preserved even when installing new versions of Amaya. It may contain the following
files:

• thot.rc: Contains the user preferences, changed through the Preferences dialog.

• amaya.keyboard (Unix), amaya.kb (Windows) or amaya.kb-mac (Mac OS X): Defines
Amaya keyboard shortcuts for the corresponding platform.

• amaya.css: Contains the user's style sheet.
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• dictionary.DCT: Amaya provides a multilingual spell checker. By default, the spell checker
works with two dictionaries: English and French (you can download other dictionaries from the
W3C servers). When you want to register a new word, the spell checker creates or updates this
personal dictionary.

Note:
The amaya.keyboard, amaya.kb, amaya.kb-mac, and amaya.css files are loaded at launch time. If you
change them, you must quit and restart Amaya to take the changes into account.

27.3. The AmayaTemp directory
Amaya stores all the temporary files it creates in a directory called the AmayaTemp directory. The
following table shows where this directory is stored within different architectures:

Unix $HOME/.amaya

Windows
$HOMEDRIVE:\$HOMEPATH\amaya

by default
C:\Documents and Settings\$user_name\amaya

Mac OS X ~/.amaya

Amaya creates files in this directory when browsing or printing a document. The cache is also stored in
this directory. You can change the cache directory by using the Cache preferences.

Amaya always tries to delete the temporary files it creates. However, if Amaya crashes, the temporary
files are not deleted. This will not impact subsequent executions of Amaya.

27.1. Preferences
These dialogs are found under the Preferences entry on the Edit menu (Amaya menu on MacOS X).
Nine preferences dialogs are available: General, Browsing, Publishing, Cache, Proxy, Colors,
Window geometry, Annotations, WebDAV, Templates, Mail.

Each of these dialogs contains three action buttons:

• Apply: Validates and stores the options shown

• Defaults: Restores, but does not save, the default values. Use the Apply button to validate the
options.

• Cancel: Dismisses the dialog.

27.1.1. General preferences
> 27.1.1.1. Profile

Amaya may be configured so as to include more of less features, with their corresponding user interface
components. The set of features available at a given time is called a profile.

In General preferences a menu allows you to choose the profile that meets your needs (Lite, Lite+Math,
etc.). The chosen profile is not applied immediately when pressing the Apply button. You have to restart
Amaya to activate the new profile.

> 27.1.1.2. Panel bar position
Tool panels can be displayed, on left side of the window, or on the right side of the window, or
customizable.
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If you select the Customizable option, you may:

• Re-order the list of panels: You click on the title of the panel and drag it to the right position in
the list.

• Display panels on both sides to get access to all tools at the same time: You can move a tool
panel by clicking on its title and drag it to the other window side. The final position of the
cursor (not the panel) must be exactly on the window side.

• Detach a panel: If you move a tool panel to a different position than a window side, the panel is
set floating.

• Remove/Add a panel: When you click on the cross in the panel title, the panel is remoed. You
can also close and open a panel with the Show/Hide toolbars submenu of the Views menu.

> 27.1.1.3. Font and language options
This section of the General preferences dialog lets you choose the font zoom level and define the
dialogue language used in Amaya. These options are explained below.

Font Zoom.You can zoom in and out, document window by document window. Each document (text
and images) displayed within a zoomed window will be displayed larger or smaller than its real size
according to the current zoom. This option enables you to change the font zoom for all windows. This
change affects only font sizes but not image sizes, and is reflected immediately in all open document
windows.

Dialogue language. Specifies the language for all of Amaya's menus and dialogue messages. At the
present time, alternate languages are available: American English (en), French (fr), German (de), Italian
(it), Spanish (es), Portuguese (pt), Finnish (fi), Hungarian (hu), Russian (ru), Turkish (tr), etc. When
launched, Amaya loads dialogue files according to the current dialogue language: en-, fr-, de-, it-, es-,
pt-, fi- or tr-, etc. files. These dialogue files are located in the Amaya/config directory.

> 27.1.1.4. Home page
This field specifies the URI that Amaya will load when launched or when the user clicks the home page
button. An example is http://www.w3.org

Note: A complete URI must be used.

> 27.1.1.5. Check boxes
The options below can be toggled on or off by clicking the check box next to an option name. A mark in
the box indicates that the option is active.

XML editing mode. The user can set his/her default editing mode (Text or XML).

Preserve lines when pasting. This option concerns the pasting form an external application. When that
option is active, Amaya keeps lines in the source application. If not active, newline characters are
replaced by spaces. This option is immediately effective.

Keep multiple spaces. When that option is active, Amaya generates no-break spaces to keep multiple
inserted spaces. This option is immediately effective.

Generate backup files. When that option is active, Amaya generates a backup file for each edited
document, after a given volume of modification. This option is immediately effective.

Anti-aliasing. Controls whether anti-aliased fonts are used (better rendering when this option is used).

ISO format for date. Controls whether generated dates are displayed using the ISO format (DD-MM-
YYYY) or the American format (YYYY/MM/DD).
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Show targets. Controls whether link targets should be shown in all document main views. Show targets
may be useful when one wants to create new links.

Display all shorcuts. Controls whether shortcuts sequenses should be shown in menus.

Warn when closing multiple tabs. Ask Amaya to display a dialog when several tabs are closed at the
same time.

Show "Tip of the day" at startup. Controls whether the "Tip of the day" is shown at startup.

> 27.1.1.6. Access keys
This option lets you specify the Alt or Ctrl modifier used to manage access keys of documents, or says
that access keys are ignored.

Note: The Alt modifier could not work because it is used by UI widgets.

27.1.2. Browsing preferences
The Browsing preferences dialog control loading of pages.

> 27.1.2.1. Check boxes
The options below can be toggled on or off by clicking the check box next to an option name. A mark in
the box indicates that the option is active.

Check duplicated IDs. Request to check duplicated IDs when loading a document. That option will
increase the reading time of documents.

Load images. Controls whether images should be loaded. This option is immediately effective.

Load objects. Controls whether objects should be loaded. This option is immediately effective.

Show background images. Controls whether background images should be shown. This option is only
effective when loading a new document.

Apply CSS. Controls whether CSS style sheets should be loaded and applied or not. This option is
immediately effective.

Double-click activates link. Since the first version of Amaya, users double-click a link to activate it.
This enables you to choose whether to edit a link or activate it. You can override this behavior by
deactivating this option.

> 27.1.2.2. Opening location
This option gives the default behaviour selected by the user when:

• A recent document is open from the File/Open document submenu.

• Another URI is selected in the combobox of the navigation toolbar.

> 27.1.2.3. Current screen type
Defines the current screen type. This value has an effect when a CSS style sheet specifies a media. This
option is immediately effective.

> 27.1.2.4. Language negotiation preferences
If a document exists in different languages and your server is configured to do language negotiation, you
can use this dialog to enter your language preferences (the first one has the highest priority). Try
browsing this press release, which is available in French, English, and Japanese versions. By changing
the language negotiation to the ISO codes for the above languages (fr, en, or ja) you can transparently
request any of these versions.
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27.1.3. Publishing preferences
The Publishing preferences dialog lets you set preferences for ETAGS and preconditions, whether to
verify each PUT command with a GET, set the default name for URLs ending with a slash, and enable
PUT redirections on specified domains. These options are explained below.

> 27.1.3.1. Charset for new documents
Defines the charset used for new documents.

> 27.1.3.2. Check boxes
The options below can be toggled on or off by clicking the check box next to an option name. A mark in
the box indicates that the option is active.

Add the xsl stylesheet for MathML elements. Generate a call to a xsl stylesheet able to transform
included MathML elements into external objects. This xsl stylesheet was developed by the MathML
working group to make Internet Explorer able to display this kind of compound documents.

Use the application/xhtml+xml MIME type for XHTML documents. This option, if enabled,
associated the new, official XHTML MIME type to all new XTHML documents that are published on
the Web. This option is disabled by default because not all servers can handle this MIME type at the time
of this release, Note that this requires also a change in your server configuration, if it's not storing
somewhere the metadata associated with each document. This option does not modify the MIME type of
existing documents: the MIME type that is received is the same one that will be used when saving the
document, except if you do a Save as operation, of course.

Use ETAGS and preconditions. HTTP/1.1 introduces new headers that avoid the lost updates problem
when publishing. With this option, you can detect conflicts when two users are publishing the same
document.

Verify each PUT with a GET. If you don't trust your server, this option tells Amaya to retrieve each
document as soon as it has been published and compare it with the copy stored in your workstation. If the
documents differ, Amaya will warn you.

Export CR/LF. This option, if enabled, precedes each line feed by a carriage return (DOS format).

> 27.1.3.3. Fixed line length
That option gives the maximum number of characters expected in lines generated by Amaya when it
creates a HTML or XML file. When the value is 0, Amaya uses its own default value (today 78).

> 27.1.3.4. Default name for URLs finishing in '/'
An HTTP server usually associates URLs that finish in '/' with a default name, for example,
Overview.html. This option enables you to specify the default name that Amaya should use when
publishing such a URL. Ask your Webmaster for the default name for your server.

> 27.1.3.5. Allow automatic PUT redirections on these domains
According to the HTTP/1.1 specification, PUT operations should not be automatically redirected unless
it can be confirmed by the user, because this might change the conditions under which the request was
issued. You can avoid having Amaya prompt with a PUT redirection warning by entering the name of
the server's domain to which you are publishing. You may specify one or more domains, each separated
with a space, e.g., www.w3.org groucho.marx.edu.

27.1.4. Cache preferences
Amaya provides a cache through libwww. The cache is enabled by default and is stored in the
AmayaTemp/libwww-cache directory. This tab also provides a Flush Cache button for erasing the cache
directory.
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> 27.1.4.1. Check boxes
The options below can be toggled on or off by clicking the check box next to an option name. A mark in
the box indicates that the option is active.

Enable cache. Activates or deactivates the cache.

Cache protected documents. By default, documents which are protected by a password are stored in the
cache. Use this option to override this behavior.

Disconnected mode. Always retrieves documents from the cache.

Ignore Expires: header. Does not expire cache entries.

> 27.1.4.2. Cache directory
Identifies the address of the libwww-cache directory. Changing this directory does not erase the contents
of the previous one. You must remove it yourself.

> 27.1.4.3. Cache size
Gives the size, in megabytes, of the cache repository.

> 27.1.4.4. Cache entry size limit
Gives the maximum size for a cache entry.

> 27.1.4.5. Flush cache
This button allows you to flush the current cache.

27.1.5. Passwords preferences
Amaya allows you to store the connection data typed in the authentication dialog. These data are the
user's name and user's password associated to a server name/realm name pair.

> 27.1.5.1. Remember passwords for sites
When this button is on, the authentication dialog asks the user if he wants Amaya to remember the typed
password. If off (default option), the user will not be able to store these authentication data.

> 27.1.5.2. Remove all
This option allows you to remove all the authentication datas stored in Amaya.

> 27.1.5.3. Sites
This list allows you to remove a name/password pair associated to a server name/realm name pair.

27.1.6. Proxy preferences
You can use this dialog to specify a proxy and a set of domains where the proxy should or should not be
used.

HTTP proxy.Identifies the proxy to be used for HTTP requests. You must specify the full name of the
server. If the server is running in a port other than 80, then, like in a URL, you need to add a ":" char to
the proxy name, followed by the port number. The table below provides two examples.

HTTP Proxy Entry Result

groucho.marx.edu
Declares a proxy called groucho.marx.edu running at the default port 80.
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groucho.marx.edu:1234
Declares a proxy called groucho.marx.edu, running at port 1234.

> 27.1.6.1. Proxy domain list
Lists space-separated domains where you want to use your proxy. Use the switch buttons to specify if the
proxy should or shouldn't be used with this domain list. For example:
harpo.marx.edu zeppo.marx.edu chico.marx.edu

^--------------^----> space separated entries

27.1.7. Color preferences
This dialog lets you select the default foreground and background colors for documents. It enables you to
control the colors used by Amaya to display the current selection.

• Document foreground color is the default foreground color of displayed pages.

• Document background color is the default background color of displayed pages.

• Selection color is the foreground color that shows the selection when it's limited to an insert
point.

• Selection background color is the background color that shows the current selection when it's
extended.

All these colors may be selected by name, hex code, or RGB format:

▪ Proposed valid names.

▪ Valid hexcode format is #FF00FF, for example.

▪ Valid RGB format is rgb(255, 0, 255), for example.

You can also select colors with the associated color palette.

> 27.1.7.1. Check boxe
The options below can be toggled on or off by clicking the check box next to an option name. A mark in
the box indicates that the option is active.

Color source. Activates or deactivates the coloration of document sources.

Note: Color changes will be effective when you open a new document window.

27.1.8. Window geometry preferences
Save geometry on exit. Controls whether the current windows geometry should be saved when the
application is exited.

Two buttons enable you

• to save the current window size and position of the current window,

• or to restore the default values.

Note: These changes take effect when you open new document windows.

27. Configuring Amaya

91



27.1.9. Configuring annotation settings
> 27.1.9.1. Annotation user

The author of the annotation. By default, Amaya uses the login name of the user. This field enables you
to change your user name to something more meaningful.

> 27.1.9.2. Annotation post server
This setting defines the server to which the annotations are posted. Local annotations are always saved to
the local repository, and by default, this setting is empty. The post server is not automatically included in
the list of servers, so you should enter the post server name in both places.

> 27.1.9.3. Annotation servers
A list of servers Amaya should contact when looking for annotations. You can specify one or more
servers. The reserved server name localhost tells Amaya to search the local annotations, but does not
necessarily mean that a local annotation server is running (or it would show a complete URL ).Under
Unix, the annotation servers are specified as a space separated list. Under Windows, you can add a new
server name by clicking in the Annotations servers list, pressing the Enter key, and then typing the
server name . By default, this list is initialized to localhost.

Tip: To temporarily disable an annotation server, add a "-" char before its URL. Amaya will ignore it.

> 27.1.9.4. Check boxes
The options below can be toggled on or off by clicking the check box next to an option name. A mark in
the box indicates that the option is active.

Autoload local annotations. Whether Amaya should request local annotations automatically every time
you browse a new Web page. If it is not checked, then you can manually choose Load annotations from
the Tools/Annotations submenu.

Autoload remote annotations. Whether Amaya should request remote annotations automatically (by
querying the annotation server) every time you browse a new Web page. If it is not checked, then you
can manually choose Load annotations from the Tools/Annotations submenu.

Note: You may experience a delay when Amaya loads remote annotations in resolving the DNS name of
the annotation servers.

Disable remote autoload at each startup (for offline work). Whether Amaya should reset the autoload
remote annotationsoption at launch time. This option can be useful if you are working offline, but still
want to autoload the local annotations as well as the remote ones.
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28. Changing keyboard shortcuts
Keyboard shortcuts are useful to invoke menu commands directly from the keyboard. You can
accomplish this using keyboard shortcuts files (one per paltform). These files define associations
between an invoked command and a keyboard sequence. They are located in the Amaya/config
directory: amaya.keyboard (Linux), amaya.kb (Windows) and amaya.kb-mac (Mac OS X).

• List of default keyboard shortcuts for Linux

• List of default keyboard shortcuts for Windows

• List of default keyboard shortcuts for Mac OS X

You can modify these files to define your own shortcuts. The syntax to define an association is:

Directive = KeySeq ':' IdentCommand ;
KeysSeq = KeySet [ ',' KeySet ] ;
KeySet = [ Modifier ] [ 'Shift' ] Key ;
Key = '<Key>' KeyValue / '<Key>' SpecialKey ;
Modifier = 'Ctrl' / 'Alt' / 'Meta' ;
KeyValue = 'a' / 'b' / ... ;
SpecialKey = 'Escape' / 'Delete' / 'Space' / 'BackSpace' /

'Enter' / 'Up' / 'Down' / 'Left' / 'Right' /
'Home' / 'End' / 'F1' / ... / 'L1' / ... / 'R1' / ... ;

IdentCommand = 'TtcInsertChar(' Char ')' / NAME '()' ;
Char = KeyValue / OctalValue / Entity ;

OctalValue = '\' NUMBER ;
Entity = DecEntity / HexaEntity ;
DecEntity = '&' '#' NUMBER ';' ;
HexaEntity = '&' '#' 'x' HEXADECIMAL ';' ;

The list of available commands is (an up to date list can be found in Amaya's sources : Amaya/amaya/
EDITOR.A) :

• Moving commands:
◦ Move character by character: TtcNextChar, TtcPreviousChar
◦ Move word by word: TtcNextWord, TtcPreviousWord
◦ Move to then beginning/end of the current line: TtcStartOfLine, TtcEndOfLine
◦ Move line by line:TtcNextLine,TtcPreviousLine
◦ Move element by element: TtcNextElement,TtcPreviousElement,

TtcChildElement, TtcParentElement
◦ Scroll from page to page: TtcPageDown, TtcPageUp,TtcPageTop,TtcPageEnd
◦ Scroll one line up or one line down: TtcLineUp, TtcLineDown

• Selection extension commands:
◦ Select character by character: TtcNextSelChar, TtcPreviousSelChar
◦ Select word by word: TtcNextSelWord, TtcPreviousSelWord
◦ Select to then beginning/end of the current line:

TtcStartOfLine,TtcSelStartOfLine, TtcSelEndOfLine
◦ Select line by line:TtcNextSelLine,TtcPreviousSelLine

• Follow a link or activate an HTML form element (menu, button, etc.): DoAction.

• Skip to the next (or the first if there is selection) link or HTML form element in the document:
NextLinkOrFormElement.
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• Skip to the previous link or HTML form element in the document:
PreviousLinkOrFormElement.

• In File menu:
NewXHTML, NewMathML, NewSVG, NewCss, OpenDoc, Reload, GotoPreviousHTML,
GotoNextHTML, GoToHome, SaveDocument, SaveDocumentAs, Synchronize, SetupAndPrint,
PrintAs, CloseDocument, AmayaCloseTab,AmayaCloseWindow, AmayaClose.

• In Edit menu:
TtcUndo, TtcRedo, TtcCutSelection, TtcCopySelection, TtcPaste,
TtcDeleteSelection, SetBrowserEditor, TtcSearchText, SpellCheck, TransformType,
ConfigAmaya.

• In Views menu:
ShowPanel, FullScreen, ShowMapAreas, ShowTargets, ZoomIn, ZoomOut, ShowLogFile,
ShowFormatted, ShowStructure, ShowAlternate, ShowLinks, ShowToC, ShowSource,
SplitHorizontally, SplitVerically.

• In Insert menu:
◦ CreateAddress CreateParagraph, CreateImage, CreateHorizontalRule,

CreateBlockQuote, CreatePreformatted, CreateAddress, CreateDivision,
CreateNOSCRIPT, CreateObject, CreateParameter, CreateIFrame,
CreateBreak,MakeBook, CreateAreaRect, CreateAreaCircle, CreateAreaPoly,
CreateForm, CreateFileInput, CreateImageInput, CreatePasswordInput,
CreateHiddenInput, CreateLabel, CreateFieldset, CreateOptGroup,
CreateToggle, CreateRadio, CreateOption, CreateTextInput,
CreateTextArea, CreateSubmit, CreateReset,CreateHeading1,
CreateHeading2, CreateHeading3, CreateHeading4, CreateHeading5,
CreateHeading6, CreateList, CreateNumberedList, CreateDefinitionList,
CreateDefinitionTerm, CreateDefinitionDef, CreateObject,
CreateParameter

◦ CreateTable, CreateCaption, CreateTHead, CreateTBody, CreateTFoot,
CreateRow, CreateDataCell, CreateHeadingCell

◦ CreateBase, CreateMeta, CreateLinkInHead, CreateScript, CreateStyle,
CreateComment.

◦ SetOnOffEmphasis, SetOnOffStrong, SetOnOffCite, SetOnOffDefinition,
SetOnOffCode, SetOnOffVariable, SetOnOffSample, SetOnOffKeyboard,
SetOnOffAbbr, SetOnOffAcronym, SetOnOffINS, SetOnOffDEL.

◦ SetOnOffItalic, SetOnOffBold, SetOnOffTeletype, SetOnOffBig,
SetOnOffSmall, SetOnOffSub, SetOnOffSup, SetOnOffQuotation, SetOnOffBDO.

◦ CreateInlineMath, CreateMath, CreateMROOT, CreateMSQRT, CreateMFRAC,
CreateMSUBSUP, CreateMSUB, CreateMSUP, CreateMUNDEROVER, CreateMUNDER,
CreateMOVER, CreateMROW, CreateMMULTISCRIPTS, CreateMTABLE

• In Format menu:
CreateClass, ApplyClass, LinkCSS, OpenCSS, DisableCSS, EnableCSS, RemoveCSS,
DoLeftAlign, DoRightAlign, DoCenter, DoJustify.

• In Links menu:
LinkToPreviousTarget, CreateOrChangeLink, CreateTarget, DeleteAnchor, MakeID.

• In Tools Menu:
ChangeTitle, DeleteColumn, AnnotateSelection, AnnotateDocument, LoadAnnotations,
PostAnnotation, DeleteAnnotation, FilterAnnot, ConfigAnnot.
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• In Help Menu:
HelpAmaya, HelpAtW3C, HelpBrowsing, HelpSelecting, HelpSearching, HelpViews,
HelpCreating, HelpLinks, HelpChanging, HelpTables, HelpMath, HelpSVG,
HelpImageMaps, HelpStyleSheets, HelpAttributes, HelpPublishing, HelpPrinting,
HelpNumbering, HelpMakeBook, HelpAnnotation, HelpConfigure, HelpShortCuts,
HelpAccess.
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29. Accessibility
The Amaya user population is extremely diverse. In addition to speaking a variety of languages and
operating on several platforms, the population contains users with visual, aural, and motor disabilities.

Because Amaya is an Open Source project, it is important to produce documents that are accessible to all
members of the user base. Amaya provides a number of accessibility features to assist you with
achieving this goal.

29.1. Accessibility features
Accessibility for people with disabilities is being improved with each release. Currently, you can perform
most Amaya functions without using a mouse, and carry out most editing functions (except entering text)
without using the keyboard.

Accessibility features in the current version include the ability to:

• Navigate and edit in Alternate, Link, Structure, and Table of contents views of a document,
which are all synchronized with the default Formatted view. See Working with document
views.

• Edit in the Source view, and manually synchronize it with other views.

• Dynamically add, remove, and edit multiple style sheets, including a user style sheet. See
Working with style sheets.

• Assign access keys for form fields, areas, or links. See About access keys.

• Use keyboard shortcuts for menu options, links, and form controls. See Selecting from the
keyboard and About keyboard shortcuts.

29.2. Producing accessible content
You can use Amaya to produce content that conforms to the W3C's Web Content Accessibility
Guidelines. Some accessibility features are already built in. For example, you cannot add an image until
you specify the alternative text because of the requirement for an alt attribute for images and imagemap
areas.

Amaya also automatically produces valid W3C-compliant markup. However, you control other features,
such as appropriate long descriptions and captioning, through the Attributes tool or the structure view.

The Amaya help currently describes how to use some HTML elements. As additional documentation is
written, it will include information on ensuring accessibility for any pages that you produce.

The most thorough guidelines are the W3C's Web Content Accessibility Guidelines. The W3C's Web
Accessibility Initiative also publishes the following quick tips for making accessible Web sites:

• Images & animations. Use the alt attribute to describe the function of each visual. For more
information, see Working with Graphics.

• Image maps. Use client-side map and text for hotspots. For more information, see Working
with image maps.

• Multimedia. Provide captioning and transcripts of audio, and descriptions of video.

• Hypertext links. Use text that makes sense when read out of context. For example, avoid using
"click here" as the link text.

• Page organization. Use headings, lists, and a consistent structure. Use CSS for layout and style
where possible. For more information, see Working with style sheets.
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• Graphs and charts. Summarize the data or use the longdesc attribute. For more information,
see Working with graphics.

• Scripts, applets, and plug-ins. Provide alternative content in case active features are
inaccessible or unsupported.

• Tables. Use tables to make line-by-line reading sensible and to summarize data. For more
information, see Working with tables.

• Frames. Display pages without frames, using NOFRAMES and meaningful titles.

• Check your work. Validate your documents prior to publishing. You can use the W3C tools,
checklist, and guidelines at:
http://www.w3.org/TR/WAI-WEBCONTENT.
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30. An introduction to HTML
This section provides a short introduction to the HTML language. It describes HTML elements and
explain how to use them.

30.1. Information types in HTML
HTML 4.0 (Strict) provides elements to denote certain types of information. Although there is a default
way each element type is presented, it is possible to use style sheets to change the presentation of any
element. The types of information that can be represented by HTML elements are:

Headings

There are six levels of headings in HTML, which should be used to mark page or topic headings in
order of their importance.

Lists

HTML provides two simple list types:
1. numbered lists (such as this one)
2. unordered lists.

It also provides for lists of terms and definitions

About the author

A special element is provided for contact information about the author of an HTML page.

Definitions

These can be marked as an inline definition (i.e. defined in a normal paragraph) or in a list of terms
and definitions. This list of information types is a definition list itself. It is also possible to use the
value glossary in the rel attribute of a link, if that link is to a definition. In Amaya, the Links and
Structure views include any rel attributes on links.

Quotations

These can be marked inline or as blocks. In each case it is possible to mark the source of the
quotation using the cite element or the cite attribute

Sample input, output, computer code

Elements are provided for samples of computer code, variables, text to be entered and
sample output.

Abbreviations and acronyms

Elements are available to denote abbreviations and acronyms.

Insertions and Deletions

There are elements to mark text that has been inserted, or should be deleted (This is useful for
collaborative editing document history).

Emphasis

HTML provides two levels of emphasis: ordinary emphasis and strong emphasis.

30.2. HTML document structure
HTML documents are fairly flat in structure - rather than having sections that contain subsections,
division of text is usually marked by different level heading elements which are alongside paragraph and
other block elements.
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There is the div element which is provided to group together a section into a single division - to use it
select the section (including its heading) you want to form part of the group and then select the option
Division (div) from the Insert menu (or use the keyboard shortcut Ctrl h Ctrl v).

There is a special structure in HTML - the link, which makes the Web a web. Further information about
how to create links, and how to create tables, is provided in the user manual section of the
documentation.

A normal HTML page should include a title, a level one heading, and an address or some information
about the author. It may also include paragraphs, lists, images, tables, and content organised into
subsections with different levels of headings.

30.3. Heading elements
HTML provides 6 levels of headings: h1, h2, h3, h4, h5, and h6. These should be used to mark
headings according to their relative importance, with h1 being the most important. Headings are block
elements, and can only be created as children of elements that have block-type content. Note that for
tables of data there are special elements to mark headings.

The first three levels of heading can be created from the toolbar using the heading images , ,
. All levels of heading can be created from the Insert menu, or using keyboard shortcuts. The default
keyboard shortcuts are Ctrl h Ctrl 1 for h1, Ctrl h Ctrl 2 for h2, and so on to Ctrl h Ctrl 6
for h6.

There are default styles for headings in most browsers to give some idea of their relative importance, but
the author can also use style sheets to provide a suggested presentation.

30.4. List elements
There are three types of list in HTML. The two simple types are ordered and unordered lists, and there is
also a definition list. Lists are block-type structures, but they can be created within other lists.

Example:

Definition list

This is a definition list - it has definition terms (dt) and definitions (dd) as children.

One definition term can be followed by a number of deifintiions.

Ordered lists

There are three types of list
1. Ordered Lists (ol)
2. Unordered Lists (ul)
3. Definition lists (dl)

Unordered Lists

Unordered lists and ordered lists share some characteristics:
• Simple lists
• Both types have children which are list items (li elements)

The three types of list can all be created from the toolbar using the list buttons , , . All types of
list can be created from the Insert menu, or using keyboard shortcuts. The default keyboard shortcuts for
unix systems are Ctrl h Ctrl l for an ordered list, Ctrl h Ctrl n for an unordered list, and Ctrl h
Ctrl d for a definition list.
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Style sheets can be used to change the presentation of lists, including changing the style of list bullets or
using an image as a bullet, and changing the style of text, for example using a different font for definition
terms and the actual definitions.

30.5. About the author
A web page should always contain some information which enables a reader to find out who wrote it or
is responsible for it. This can include an email address (which can be linked), a URI, or even a physical
address. The type address is used to identify this information, and it can contain other block-level
elements such as paragraphs, headings, and lists.

There is a default style for address elements in most browsers but the author can also use style sheets to
provide a suggested presentation.

30.6. Inline markup
Text within a paragraph, heading, or other block element can be marked up in a variety of ways, for
example to emphasise it, or to highlight text that should be entered by a user into a computer. Most of
these inline elements are described in this page, although links, which are inline elements, are described
separately.

30.6.1. Definitions
The dfn element is used to mark an inline definition (a word which is given as a defining instance)

Style sheets can be used to change the presentation of inline definitions.

30.6.2. Inline quotations
Quotations which are inline can be marked using the information type "quotation" - the HTML element
q. This element is selected from the Character elements submenu of the Insert menu, or with the
keyboard shortcut Ctrl i Ctrl q. It is possible to give a URI source for the quotation, using the cite
attribute.

Style sheets can be used to change the presentation of inline quotations. The HTML specification states
that inline quotation should be rendered with the appropriate punctuation marks for the language being
represented.

30.6.3. Sample input, output and computer code
Elements are provided to mark computer code, such as statement:do-something, with separate
markup for variables, as well as user input and program output - the elements code, var, kbd
and samp. These elements are found in the Information types submenu of the Insert menu, and there
are keyboard shortcuts for all of them - Ctrl i followed by Ctrl t for code, Ctrl v for variables,
Ctrl k for user input and Ctrl m for sample output.

Style sheets can be used to change the presentation of these elements.

30.6.4. Acronyms and abbreviations
Acronyms and abbreviations should be marked as such, using the abbr and acronym elements available
in the Information types submenu of the Insert menu. There is also the shortcut Ctrl i Ctrl y for
acronym. This allows recognition for different types of systems.

The title attribute can also be used to specify the expansion of the acronym. Select the text to be
marked, for example W3C, select the Insert menu, the information types submenu, and the option
acronym. Then select the entire element (F2 key), open the Attributes menu, select title, enter World
Wide Web Consortium, and apply it.
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Style sheets can be used to change the presentation of acronyms or abbreviations.

30.6.5. Insertions and deletions
The del and ins elements are available in the Information types submenu of the Insert menu to mark
text which ought to be deleted or which has already been inserted.

Style sheets can be used to change the presentation of insertions and deletions.

30.6.6. Emphasis elements
HTML has elements to define two levels of emphasis:

1. Ordinary emphasis, using the em element and

2. Strong emphasis, using the strong element.

Both types of emphasis can be applied from the toolbar using the and buttons, or from the
Information types submenu of the Insert menu. There are also standard keyboard shortcuts - Ctrl i
Ctrl e for emphasis (because the default rendering is often italicised text) and Ctrl i Ctrl s for
strong emphasis (becuase the default rendering is often bold text). If there is a current selection, the
emphaisis is applied to that, otherwise the appropriate element is created, as a child of the current
element.

The emphasis elements are toggled in Amaya - to remove an emphasis select the element and reapply the
appropriate emphasis. For example place the cursor somewhere in a strong element, use the F2 key to

select the element, and then use the keyboard shortcut, menu item, or the button - the strong
element will be removed.

Style sheets can be used to change the presentation of both types of emphasis.

30.6.7. Span element
The span element in conjunction with a id (style or class) attribute offers a generic mechanism for adding
structure to a document. This element is generated by Amaya when the user applies an attribute to a
piece of text. It's removed when the attribute is deleted.

30.7. Character style elements in HTML
What NOT to do and how it should be done...

HTML 4.0 (Strict) includes some elements which provide character styles. These elements should be
replaced by the use of structural elements or style sheets wherever possible.

All the elements in question except PRE are found in the Character Element submenu of the XHTML
menu:

b and i

These should be replaced by use of the strong and em elements where they are used to provide
emphasis for a word or phrase. There are special elements to denote headings, terms that are being
defined, and certain special uses, such as a quotation, piece of computer code, etc. If the elements
are simply being used to provide heavier font style sheets should be used instead

big and small

In general these effects should be achieved with style sheets. Where they are used to denote specific
types of information such as the source of a quotation, sample computer input or output, etc, there
are appropriate HTML elements that should be used.
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sub and sup

Style sheets should be used to achieve the presentation effects of these elements. In cases such as
mathematical expressions, an appropriate markup language such as MathML should be used where
possible.

tt and pre

Authors should use style sheets to achieve these effects.

30.8. HTML elements
Amaya recognizes all the elements available in the HTML 4.0 language, but only generates elements that
are not deprecated. The following list contains the elements that can be generated in Amaya, each linked
to the HTML specification for the element. Help information is also available about these elements.

a

anchor - a link and/or target

abbr

abbreviated form (e.g., WWW, HTTP, etc.)

acronym

an acronym: a type of abrreviation that is usually pronounced as a word. (e.g., laser, WYSIWYG)

address

information about the author

area

client-side image map area

b

bold text style (This effect should be achieved using style sheets or markup that conveys structural
information)

base

document base URI

bdo

I18N BiDi over-ride

big

large text style (This effect should be achieved using style sheets or markup that conveys structural
information)

blockquote

long quotation

body

document body

br

forced line break

button

push button
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../Amaya/doc/WX/HTML-elements/HTML-elements/infoTypes.html
http://www.w3.org/TR/REC-html40/struct/links.html#edef-A
http://www.w3.org/TR/REC-html40/struct/text.html#edef-ABBR
http://www.w3.org/TR/REC-html40/struct/text.html#edef-ACRONYM
http://www.w3.org/TR/REC-html40/struct/global.html#edef-ADDRESS
http://www.w3.org/TR/REC-html40/struct/objects.html#edef-AREA
http://www.w3.org/TR/REC-html40/present/graphics.html#edef-B
../Amaya/doc/WX/HTML-elements/StyleSheets.html
../Amaya/doc/WX/HTML-elements/HTML-elements/infoTypes.html
../Amaya/doc/WX/HTML-elements/HTML-elements/infoTypes.html
http://www.w3.org/TR/REC-html40/struct/links.html#edef-BASE
http://www.w3.org/TR/REC-html40/struct/dirlang.html#edef-BDO
http://www.w3.org/TR/REC-html40/present/graphics.html#edef-BIG
../Amaya/doc/WX/HTML-elements/StyleSheets.html
../Amaya/doc/WX/HTML-elements/HTML-elements/infoTypes.html
../Amaya/doc/WX/HTML-elements/HTML-elements/infoTypes.html
http://www.w3.org/TR/REC-html40/struct/text.html#edef-BLOCKQUOTE
http://www.w3.org/TR/REC-html40/struct/global.html#edef-BODY
http://www.w3.org/TR/REC-html40/struct/text.html#edef-BR
http://www.w3.org/TR/REC-html40/interact/forms.html#edef-BUTTON


caption

table caption

cite

citation

code

computer code fragment

col

table column

colgroup

table column group

dd

definition description

del

deleted text

dfn

instance definition

div

generic language/style container

dl

definition list

dt

definition term

em

emphasis

fieldset

form control group

form

interactive form

h1, h2, h3, h4, h5, h6

heading

head

document head

hr

horizontal rule

html

document root element
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http://www.w3.org/TR/REC-html40/struct/tables.html#edef-CAPTION
http://www.w3.org/TR/REC-html40/struct/text.html#edef-CITE
http://www.w3.org/TR/REC-html40/struct/text.html#edef-CODE
http://www.w3.org/TR/REC-html40/struct/tables.html#edef-COL
http://www.w3.org/TR/REC-html40/struct/tables.html#edef-COLGROUP
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http://www.w3.org/TR/REC-html40/interact/forms.html#edef-FORM
http://www.w3.org/TR/REC-html40/struct/global.html#edef-H1
http://www.w3.org/TR/REC-html40/struct/global.html#edef-HEAD
http://www.w3.org/TR/REC-html40/present/graphics.html#edef-HR
http://www.w3.org/TR/REC-html40/struct/global.html#edef-HTML


i

italic text style (This effect should be achieved using style sheets or markup that conveys structural
information)

iframe

inline subwindow

img

Embedded image

input

form control

ins

inserted text

kbd

text to be entered by the user

label

form field label text

legend

fieldset legend

li

list item

link

a media-independent link

map

client-side image map

meta

generic metainformation

noscript

alternate content container for non script-based rendering

object

generic embedded object

ol

ordered list

optgroup

option group

option

selectable choice

p

paragraph
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http://www.w3.org/TR/REC-html40/present/graphics.html#edef-I
../Amaya/doc/WX/HTML-elements/StyleSheets.html
../Amaya/doc/WX/HTML-elements/HTML-elements/infoTypes.html
../Amaya/doc/WX/HTML-elements/HTML-elements/infoTypes.html
http://www.w3.org/TR/REC-html40/present/frames.html#edef-IFRAME
http://www.w3.org/TR/REC-html40/struct/objects.html#edef-IMG
http://www.w3.org/TR/REC-html40/interact/forms.html#edef-INPUT
http://www.w3.org/TR/REC-html40/struct/text.html#edef-ins
http://www.w3.org/TR/REC-html40/struct/text.html#edef-KBD
http://www.w3.org/TR/REC-html40/interact/forms.html#edef-LABEL
http://www.w3.org/TR/REC-html40/interact/forms.html#edef-LEGEND
http://www.w3.org/TR/REC-html40/struct/lists.html#edef-LI
http://www.w3.org/TR/REC-html40/struct/links.html#edef-LINK
http://www.w3.org/TR/REC-html40/struct/objects.html#edef-MAP
http://www.w3.org/TR/REC-html40/struct/global.html#edef-META
http://www.w3.org/TR/REC-html40/interact/scripts.html#edef-NOSCRIPT
http://www.w3.org/TR/REC-html40/struct/objects.html#edef-OBJECT
http://www.w3.org/TR/REC-html40/struct/lists.html#edef-OL
http://www.w3.org/TR/REC-html40/interact/forms.html#edef-OPTGROUP
http://www.w3.org/TR/REC-html40/interact/forms.html#edef-OPTION
http://www.w3.org/TR/REC-html40/struct/text.html#edef-P


param

named property value

pre

preformatted text

q

short inline quotation

samp

sample program output, scripts, etc.

script

script statements

select

option selector

small

small text style (This effect should be achieved using style sheets or markup that conveys structural
information)

span

generic language/style container

strong

strong emphasis

style

style information

sub

subscript

sup

superscript

table

A table

tbody

table body

td

table data cell

textarea

multi-line text field

tfoot

table footer block

th

table header cell
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http://www.w3.org/TR/REC-html40/struct/text.html#edef-SAMP
http://www.w3.org/TR/REC-html40/interact/scripts.html#edef-SCRIPT
http://www.w3.org/TR/REC-html40/interact/forms.html#edef-SELECT
http://www.w3.org/TR/REC-html40/present/graphics.html#edef-SMALL
../Amaya/doc/WX/HTML-elements/StyleSheets.html
../Amaya/doc/WX/HTML-elements/HTML-elements/infoTypes.html
../Amaya/doc/WX/HTML-elements/HTML-elements/infoTypes.html
http://www.w3.org/TR/REC-html40/struct/global.html#edef-SPAN
http://www.w3.org/TR/REC-html40/struct/text.html#edef-STRONG
http://www.w3.org/TR/REC-html40/present/styles.html#edef-STYLE
http://www.w3.org/TR/REC-html40/struct/text.html#edef-SUB
http://www.w3.org/TR/REC-html40/struct/text.html#edef-SUP
http://www.w3.org/TR/REC-html40/struct/tables.html#edef-TABLE
http://www.w3.org/TR/REC-html40/struct/tables.html#edef-TBODY
http://www.w3.org/TR/REC-html40/struct/tables.html#edef-TD
http://www.w3.org/TR/REC-html40/interact/forms.html#edef-TEXTAREA
http://www.w3.org/TR/REC-html40/struct/tables.html#edef-TFOOT
http://www.w3.org/TR/REC-html40/struct/tables.html#edef-TH


thead

table header block

title

document title

tr

table row, containing table cells.

tt

teletype or monospaced text style (This effect should be achieved using style sheets or markup that
conveys structural information)

ul

unordered list

var

instance of a variable or program argument

Amaya does not allow the user to create Framesets. It is possible to edit framesets in the structure view -
elements can be copied and pasted, and appropriate attributes are available.

frame

subwindow

frameset

window subdivision

noframes

alternate content container for non frame-based rendering

Amaya does not create the following elements which are deprecated in HTML 4.0 Strict (i.e. should no
longer be used). They should be replaced as noted for each element:

applet

Should be replaced by the object element

basefont

Should be replaced by the use of style sheets

center

Should be replaced by the use of style sheets

dir

Should be replaced by the ul element

font

Should be replaced by the use of style sheets

isindex

Should be replaced by the use of forms

menu

Should be replaced by the ul element
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s and strike

Should be replaced by the use of del (to identify text to be removed) or by style sheets

u

Should be replaced by the use of style sheets

Copyright © 1994-2008 INRIA and W3C® (MIT, ERCIM, Keio), All Rights Reserved. W3C liability,
trademark, document use and software licensing rules apply. Your interactions with this site are in accordance
with our public and Member privacy statements.
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